Oracle® Solaris 11 Accessibility Guide for the GNOME Desktop
This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

This software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007).

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices.

This software and hardware documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

Ce logiciel et la documentation qui l’accompagne sont protégés par les lois sur la propriété intellectuelle. Ils sont concédés sous licence et soumis à des restrictions d’utilisation et de divulgation. Sauf disposition de votre contrat de licence ou de la loi, vous ne pouvez pas copier, reproduire, traduire, diffuser, modifier, brever, transmettre, distribuer, exposer, exécuter, publier ou afficher le logiciel, même partiellement, sous quelque forme et par quelque procédé que ce soit. Par ailleurs, il est interdit de procéder à toute ingénierie inverse du logiciel, de le désassembler ou de le décompiler, excepté à des fins d’interopérabilité avec des logiciels tiers ou tel que prescrit par la loi.

Les informations fournies dans ce document sont susceptibles de modification sans préavis. Par ailleurs, Oracle Corporation ne garantit pas qu’elles soient exemptes d’erreurs et vous invite, le cas échéant, à lui en faire part par écrit.

Si ce logiciel, ou la documentation qui l’accompagne, est concédé sous licence au Gouvernement des Etats-Unis, ou à toute entité qui délivre la licence de ce logiciel ou l’utilise pour le compte du Gouvernement des Etats-Unis, la notice suivante s’applique :

U.S. GOVERNMENT RIGHTS. Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007).

Ce logiciel ou matériel a été développé pour un usage général dans le cadre d’applications de gestion des informations. Ce logiciel ou matériel n’est pas conçu ni n’est destiné à être utilisé dans des applications à risque, notamment dans des applications pouvant causer des dommages corporels. Si vous utilisez ce logiciel ou matériel dans le cadre d’applications dangereuses, il est de votre responsabilité de prendre toutes les mesures de secours, de sauvegarde, de redondance et autres mesures nécessaires à son utilisation dans des conditions optimales de sécurité. Oracle Corporation et ses affiliés déclinent toute responsabilité quant aux dommages causés par l’utilisation de ce logiciel ou matériel pour ce type d’applications.

Oracle et Java sont des marques déposées d’Oracle Corporation et/ou de ses affiliés. Tout autre nom mentionné peut correspondre à des marques appartenant à d’autres propriétaires qu’Oracle.

AMD, Opteron, le logo AMD et le logo AMD Opteron sont des marques ou des marques déposées d’Advanced Micro Devices. Intel et Intel Xeon sont des marques ou des marques déposées d’Intel Corporation. Toutes les marques SPARC sont utilisées sous licence et sont des marques ou des marques déposées de SPARC International, Inc. UNIX est une marque déposée concédée sous licence par X/Open Company, Ltd.

Copyright © 2011, Oracle and/or its affiliates. All rights reserved.
Contents

Preface ..................................................................................................................................................... 7

1 Introduction to Accessibility ............................................................................................................. 11
   Overview of Accessibility ............................................................................................................... 11

2 Using Assistive Technologies ........................................................................................................ 13
   Orca Screen Reader and Magnifier ............................................................................................. 13
      Braille Support ......................................................................................................................... 14
      Available Voices ..................................................................................................................... 14
      Magnification in Orca ............................................................................................................. 14
   ▼ To Enable Orca ......................................................................................................................... 14
      Using Orca .............................................................................................................................. 16
      Orca Configuration GUI ......................................................................................................... 17
      Using the Orca Keyboard Commands .................................................................................... 38
      Application-Specific Information .......................................................................................... 44
      To Enable Braille .................................................................................................................... 45
      Troubleshooting Orca ........................................................................................................... 45
   Disabling the Screensaver ............................................................................................................. 45
   To Change the PDF Viewer Application ...................................................................................... 46

3 Configuring the Mouse and Keyboard ..................................................................................... 47
   Configuring the Mouse .............................................................................................................. 47
      Configuring the Behavior of the Mouse .................................................................................. 47
      Configuring the Cursor ........................................................................................................... 49
      Using MouseTweaks .............................................................................................................. 49
   To Use the Keyboard to Emulate the Mouse ............................................................................. 50
   Configuring an Accessible Keyboard .......................................................................................... 50
### Contents

Configuring a Keyboard-Based Mouse ................................................................. 51
Using Dasher ......................................................................................................... 51
   ▼ To Install Dasher ......................................................................................... 51
   ▼ To Start Dasher ......................................................................................... 52

4 Using the Keyboard to Navigate the Desktop .................................................. 53
   Introduction to Keyboard Navigation .............................................................. 53
      Essential Keyboard Shortcuts ..................................................................... 53
      Global Keyboard Shortcuts ......................................................................... 54
   Navigating the Desktop Background .............................................................. 55
   Navigating Panels .......................................................................................... 56
      ▼ To Move a Panel Object .......................................................................... 56
      Navigating Drawers .................................................................................... 57
      Navigating Menus on Panels ...................................................................... 58
      Navigating Panel Applications .................................................................. 58
   Navigating Your Workspaces .......................................................................... 59
   Navigating Windows ....................................................................................... 59
      Giving Focus to a Window .......................................................................... 59
      Controlling a Window ................................................................................ 60
      Moving a Window ...................................................................................... 60
      Resizing a Window .................................................................................... 61
      Navigating Paned Windows ....................................................................... 61
   Navigating Applications ................................................................................ 62
      Essential Keyboard Shortcuts for Navigating Applications ....................... 62
      Essential Keyboard Shortcuts for Navigating Dialogs ............................... 63
   Navigating the File Manager ......................................................................... 64
      Navigating Folders ..................................................................................... 64
      Navigating the Side Pane .......................................................................... 65
   Navigating HTML Content in Caret Navigation Mode .................................... 65
   Navigating Standard Elements and Controls ............................................... 66
      Navigating Menus ...................................................................................... 66
      Navigating Buttons ................................................................................... 66
      Navigating Radio Buttons ......................................................................... 67
      Navigating Check Boxes .......................................................................... 67
      Navigating Text Boxes ............................................................................. 68
Navigating Spin Boxes ................................................................................................................. 70
Navigating Drop-Down Lists ..................................................................................................... 70
Navigating Drop-Down Combination Boxes ......................................................................... 71
Navigating Sliders ........................................................................................................................ 72
Navigating Tabbed Sections ..................................................................................................... 72
Navigating Lists ............................................................................................................................ 74
Navigating Trees .......................................................................................................................... 75
Customizing Your Keyboard Shortcuts ............................................................................................ 76
▼ To Customize Keyboard Shortcuts ........................................................................................ 77
▼ To Disable a Keyboard Shortcut ......................................................................................... 77

5 Customizing the Appearance of the Desktop ................................................................................ 79
Customization Options .................................................................................................................. 79
Using Themes to Customize the Desktop ................................................................................... 80
Introduction to Themes ................................................................................................................ 80
▼ To Choose a Theme ................................................................................................................ 81
▼ To Modify the Controls Setting for a Theme ........................................................................ 82
▼ To Modify the Color Setting for a Theme .............................................................................. 83
▼ To Modify the Window Border Setting for a Theme ......................................................... 83
▼ To Modify the Icon Setting for a Theme ................................................................................ 84
▼ To Modify the Mouse Pointer Setting for a Theme .......................................................... 84
Customizing Specific Components of the Desktop ...................................................................... 85
▼ To Customize the Desktop Background ............................................................................... 85
▼ To Set the Background to a Solid or Gradated Color .............................................................. 85
▼ To Set the Background to a Picture ...................................................................................... 85
▼ To Customize Desktop Background Objects ....................................................................... 86
Customizing Fonts ....................................................................................................................... 86
Meeting Specific Accessibility Needs ........................................................................................... 88
▼ To Achieve a High-Contrast or Low-Contrast Desktop ...................................................... 88
▼ To Achieve a Large Print Desktop .......................................................................................... 88

6 System Administration ............................................................................................................. 91
Configuring the Desktop for Accessible Login .......................................................................... 91
Configuring the Java Environment for Accessibility on Oracle Solaris Systems .................... 91
▼ To Configure the Java Environment on Oracle Solaris Systems ........................................ 92
Preface

The Oracle Solaris 11 Accessibility Guide for the GNOME Desktop describes how to configure, customize, and use the accessibility features of the Oracle Solaris 11 Desktop. Most of the information in this guide is generic to all releases of the Oracle Solaris Desktop, see (need to link to Supported Systems section). Where the information is not generic, the platform is indicated.

Supported Systems

This release of the Oracle Solaris Desktop supports systems running the Oracle Solaris 11 operating system on SPARC and x86 platforms.

Who Should Read This Guide

This guide is for users, system administrators, and anyone who is interested to know how the Oracle Solaris Desktop supports people with disabilities.

How This Book Is Organized

This guide is structured in the following manner:

- Chapter 1, “Introduction to Accessibility,” provides an overview of accessibility requirements and how they are met by the Oracle Solaris Desktop.
- Chapter 2, “Using Assistive Technologies,” explains how to use the assistive technology applications, such as the Screen Reader, Magnifier, and Braille Output, that are available in the Oracle Solaris Desktop.
- Chapter 3, “Configuring the Mouse and Keyboard,” describes how to adjust the behavior of the keyboard, mouse, and other pointing devices.
- Chapter 4, “Using the Keyboard to Navigate the Desktop,” describes how to use the Oracle Solaris Desktop and applications with the keyboard alone.
- Chapter 5, “Customizing the Appearance of the Desktop,” describes how to adjust the size and colors of text and graphics on the Oracle Solaris Desktop.
- Chapter 6, “System Administration,” describes tasks that may need to be performed by a system administrator to enable certain accessibility features of the Oracle Solaris Desktop.
### Access to Oracle Support


---

### Typographic Conventions

The following table describes the typographic conventions that are used in this book.

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>The names of commands, files, and directories, and onscreen computer output</td>
<td>Edityour .login file. Use <code>ls -a</code> to list all files. <code>machine_name% you have mail</code>.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>What you type, contrasted with onscreen computer output</td>
<td><code>machine_name% su</code> <code>Password:</code></td>
</tr>
<tr>
<td>aabbcc123</td>
<td>Placeholder: replace with a real name or value</td>
<td>The command to remove a file is <code>rm filename</code>.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Book titles, new terms, and terms to be emphasized</td>
<td>Read Chapter 6 in the <em>User's Guide</em>. A <code>cache</code> is a copy that is stored locally. Do not save the file. <strong>Note:</strong> Some emphasized items appear bold online.</td>
</tr>
</tbody>
</table>

---

### Shell Prompts in Command Examples

The following table shows the default UNIX system prompt and superuser prompt for shells that are included in the Oracle Solaris OS. Note that the default system prompt that is displayed in command examples varies depending on the Oracle Solaris release.

<table>
<thead>
<tr>
<th>Shell</th>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bash shell, Korn shell, and Bourne shell</td>
<td>$</td>
</tr>
<tr>
<td>Shell</td>
<td>Prompt</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Bash shell, Korn shell, and Bourne shell for superuser</td>
<td>#</td>
</tr>
<tr>
<td>C shell</td>
<td><code>machine_name%</code></td>
</tr>
<tr>
<td>C shell for superuser</td>
<td><code>machine_name#</code></td>
</tr>
</tbody>
</table>
Introduction to Accessibility

This chapter introduces you to accessibility in the Oracle Solaris Desktop.

Overview of Accessibility

The accessibility features enable people with disabilities to use the software easily and efficiently.

The Oracle Solaris Desktop is easy to use and incorporates many accessibility features. Every supported application and utility in the Oracle Solaris Desktop is designed with accessibility and usability in mind. Users with physical disabilities such as low vision or impaired motor skills can use all of the functionality of the Oracle Solaris Desktop thanks to the customization tools that are available. The customization tools enable you to customize the appearance and behavior of the desktop.

The ability to customize the Oracle Solaris Desktop contributes greatly to the accessibility of the desktop. This guide describes the various customization options available for the desktop.
The Oracle Solaris Desktop includes the Orca Screen Reader, Magnifier, and Braille Output applications to assist users with a visual impairment in using the desktop.

The desktop applications and utilities in the Oracle Solaris Desktop are also designed with accessibility and usability in mind. However, there are some exceptions where the default applications are not suitable for users with special needs. In these situations, you must change the default application to an application that is suitable for all users.

**Orca Screen Reader and Magnifier**

Orca is a flexible and powerful assistive technology for people with visual impairments. Using various combinations of speech synthesis, Braille, and magnification, Orca provides access to applications and toolkits that support the Assistive Technology Service Provider Interface (AT-SPI). Orca is free, open-source software.

The Orca Screen Reader and Magnifier applications help users with limited or no vision to use the Oracle Solaris Desktop and its associated applications. Orca provides the following functionalities:

- **Screen Reader** – Enables non-visual access to standard applications in the Oracle Solaris Desktop by using speech and Braille output
- **Magnifier** – Enables automated focus tracking and full-screen magnification to aid low-vision users

Orca is a part of the GNOME platform and its releases are coupled with the GNOME platform releases.

The following sections provide information about Orca and how to use it.
Braille Support

Braille is supported through BRLTTY and is tightly integrated with Orca. BRLTTY offers support for nearly every refreshable Braille.

Also, Orca fully supports contracted Braille output.

Available Voices

Orca provides interfaces to both gnome-speech and emacspeak speech services. Currently available voices for Orca are restricted by the speech engines supported by the available speech services.

Some of the following speech engines are available:

- Free engines:
  - eSpeak
  - Festival
  - FreeTTS
- Commercial engines:
  - Fonix DECTalk
  - Loquendo
  - Eloquence
  - Cepstral

Magnification in Orca

Orca currently uses the gnome-mag magnification service. The gnome-mag service has incorporated support for smoother full-screen magnification, which relies upon newer extensions in the X Window System server. These extensions do not always function well on all platforms, so smooth full-screen magnification might not always work.

▼ To Enable Orca

This procedure describes how to enable Orca for the first time. Press Return after each action to proceed through the setup.

You can change the settings at any time by running the --text-setup option when you start Orca, or by pressing Insert+Spacebar while Orca is running to start the Orca Configuration GUI. The settings are saved in the ~/.orca/user-settings.py file. You need to log out and log back in for the new settings to take effect.
1 Open a Run dialog by pressing Alt+F2 or Meta+R.

2 Start the text-only guided setup by typing the following command:
   orca --text-setup Enter

3 Select a language from the list.
   The default language is set to English.

   **Note** – Using the default eSpeak text-to-speech engine, Orca supports about 45 languages.

4 Determine whether to activate the Echo by Word option, which instructs Orca to speak words as you finish typing, by typing y or n.

5 Determine whether to activate the Key Echo option, which instructs Orca to speak all keys as they are pressed, by typing y or n.

6 Choose the keyboard layout that determines which key should act as the Orca modifier key, which is used in conjunction with other keys to enable keyboard access to most of the program functions.
   The options are:
   - 1 – Desktop uses the Insert key
   - 2 – Laptop uses the Caps Lock key

7 Indicate whether you require Braille output by typing y or n.
   This functionality assumes that a BRLTTY compatible device is available, although Orca can still function if you type y without a BRLTTY device available.

8 Determine whether you want an on-screen Braille output monitor by typing y or n.
   This feature is useful for developers who need to verify BRLTTY output, but may also be useful in other situations, such as visually diagnosing or verifying Braille output.
   Orca should be enabled on your system.

   **Note** – If accessibility was not yet enabled, Orca enables accessibility and then advises you to log out and restart your login session.

---

**More Information**

**Magnifier in Full Screen Mode**

If you plan to use the Magnifier portion of Orca in full screen mode, confirm that the Xserver Composite extension is enabled. To enable the Xserver Composite extension, perform the following actions:
Press Alt+F2 or Meta+R to open the Run dialog.
Type the `xdpyinfo` command and press Enter.
Look for the string `Composite` in the output.

Using Orca

This section describes the usage of Orca.

Setting Up Orca

When you run Orca for the first time, the application automatically opens in setup mode. If you want to run setup at a later point, execute the `-s setup` option the next time you run Orca. While Orca is running, you can press Insert+Spacebar to open the Orca Configuration GUI.

Orca’s Configuration GUI also has an option to let you indicate that Orca should be started automatically when you log in. For more information about the Orca’s graphical user interface, see “Orca Configuration GUI” on page 17.

Running Orca

Run Orca by typing the `orca` command in a terminal session window.

You can run Orca from a virtual console window if you do not yet have access to the GUI.

If the GUI is installed, press Alt+F2 or Meta+R. In the Run dialog, type `orca` (followed by any of the optional parameters) and press Return.

Orca automatically enters the text setup mode if you run it from a virtual console window.

Quitting Orca

1. Press Insert+Q in the desktop mode or CapsLock+Q in the laptop layout mode, to quit Orca.
   
   A confirmation dialog appears.
2. Select Quit to close Orca.
3. If the system does not respond, you can perform any one of the following:
   - Press Ctrl+Alt+F1 to get to a virtual console and enter `orca --quit` command. Then, press Alt+F7 to get back to the desktop. This procedure kills the Orca process and reclaims system resources. You can then restart Orca by using the previously outlined methods.
   - Press Ctrl+Alt+Backspace to end your login session and get back to the graphical login prompt.
**Orca Configuration GUI**

The Orca Configuration GUI enables you to customize the behavior and features of Orca, such as speech, Braille, and magnification. For example, you can select the type of speech synthesis engine you want to use, enable or disable Braille, and the type of magnification preferences you want to set. You can select the keyboard layout you want (desktop or laptop) and also examine and modify the existing keyboard layout.

To open the Orca Configuration GUI, press Orca Modifier + Spacebar, where Orca Modifier is the Insert key when you use the Desktop keyboard layout and CapsLock key when you use the Laptop keyboard layout. To change settings for a single application, press Ctrl + Orca Modifier + Spacebar while the application has focus.

For more information about the Desktop keyboard layout, see *Using the Desktop Layout Commands*.

For more information about the Laptop keyboard layout, see *Using the Laptop Layout Commands*.

**Enabling General Preferences in Orca**

The General page enables you to customize general settings of Orca such as selecting the keyboard layout and starting and quitting Orca. The options in the General page are described in the following sections.

**Keyboard Layout**

The keyboard layout section enables you to select the Desktop or Laptop layout.
For more information about the Desktop keyboard layout, see Using the Desktop Layout Commands.

For more information about the Laptop keyboard layout, see Using the Laptop Layout Commands.

**Show Orca Main Window**

The Orca main window enables you to display the Orca Configuration GUI.

The main window provides a Quit option to close the Orca Configuration GUI. You can also quit Orca by pressing Orca Modifier+Q. Because the Orca main window is included in the window manager's tab order when you press Alt+Tab to switch windows, you might want to deselect the Show Orca main window button.

**Quit Orca Without Confirmation**

When you press Orca Modifier+K to quit Orca or press the Quit button in the Orca main window, Orca displays a confirmation dialog asking whether you want to quit. Select this option to prevent the confirmation window from appearing again.

**Disable gksu Keyboard Grab**

When running commands from the Launch menu, many distributions use an application known as gksu to authorize the user to run these commands. gksu is the GUI which asks you for your password. When gksu runs, the application enables the keyboard grab feature.

Keyboard grab is a feature to prevent keyboard actions from going to any other application on the desktop, including Orca. The result of a keyboard grab is that Orca will not receive any keyboard events, preventing it from functioning normally.

By selecting the Disable gksu Keyboard Grab button, you can turn off the keyboard grab behavior, allowing Orca to function normally with system administration applications.
Note – The keyboard grab is a security attempt by gksu to prevent applications from sniffing the keyboard and grabbing secret information. Disabling the gksu keyboard grab feature can expose you to such behavior. You can use the root account for system administration purposes. To do this for system administration purposes, you need to enable the root account for login, and then logout and log back in as root whenever you want to perform a system administration command.

Present Tooltips

The Present tooltips option displays information in tooltips that appear as the result of mouse hovering. Pressing Ctrl+F1 when an object has focus always displays tooltips regardless of this setting.

Speak Object Under Mouse

When the Speak Object Under Mouse option is selected, Orca presents audio information about the object under the mouse.

Start Orca When You Login

When the Start Orca When You Login option is selected, the system automatically launches Orca when you log in.

Enabling Speech Preferences in Orca

The Speech page enables you to customize the Orca speech synthesis settings.
Enable Speech

The Enable Speech option causes Orca to make use of a speech synthesizer.

Speech System and Speech Synthesizer

These options enable you to select the speech system and synthesizer. Orca provides support for a growing number of speech systems. These include GNOME-speech, Emacspeak, and an experimental backend for Speech Dispatcher. Depending on the machine configurations, you might have all or none of these options. By default, only GNOME-speech is available.

First, determine which speech system you would like to use. Then, choose from the Speech Synthesizer list of available synthesizers.

Voice Settings

If your synthesizer supports voice settings, Orca can use multiple voices to identify special cases within an application, such as hyperlinks or uppercase text. Use the Voice Settings and Person
options to customize these settings. For example, assume you are using Fonix DECTalk and want the Betty voice to denote uppercase. Do the following:

1. Select the uppercase voice for the Voice Settings option.
2. For the Person option, select the Betty voice.

Use the next sliders to set the synthesizer’s rate, pitch, and volume.

**Punctuation Level**

Use the Punctuation Level setting to adjust the amount of punctuation spoken by the synthesizer. The following levels are available:

- None
- Some
- Most
- All

**Verbosity**

The Verbosity setting determines the amount of information that is spoken in certain situations. For example, if the Verbose level is set, the synthesizer speaks shortcut keys for items in menus. When it is set to Brief, these shortcut keys are not announced.

**Table Row Speech**

The Table Row Speech option determines the way the speech synthesizer will read items within tables. The following settings are available:

- Speak Current Row
- Speak Current Cell

The ability to adjust this behavior can be useful in many situations. For example, consider the process of browsing email messages in Evolution. In this instance, the Speak current row setting is preferable. While navigating through the list of messages, all relevant info, such as the sender, subject, and whether the message has attachments, is read automatically. While the current row setting is active, you can still read individual cells by using the left and right arrows.

*Note* – To toggle this behavior, press Orca Modifier+F11.

**Speak Blank Lines**

To hear the word blank when navigating to a blank line in a document, select the Speak Blank Lines option.
**Speak Multicase Strings as Words**

The Speak Multicase Strings As Words option causes Orca to break a word prior to passing it along to the speech synthesizer. So words in code, consisting of several words with alternating case are pronounced correctly.

For example, the word “MultiCaseString” can be broken into separate words Multi, Case, and String.

**Speak Tutorial Messages**

If the Speak Tutorial Messages option is selected, when moving from one component to another in an interface, Orca provides information about the component that is currently focused.

**Speak Object Mnemonics**

The Speak Object Mnemonics option causes Orca to announce the mnemonic associated with the object in focus. For example, Alt+O for the OK button.

**Break Speech Into Chunks Between Pauses**

Depending on the enabled speech settings, Orca might provide some information about a particular object such as its name, role, state, mnemonic, and tutorial message. The Break Speech Into Chunks Between Pauses option causes Orca to insert brief pauses in between each piece of information.

**To Speak Child Position**

The Speak Child Position checkbox enables Orca to announce the position of the focused item in menus and lists. For example, 9 of 16.

**To Speak Indentation and Justification**

The Speak Indentation And Justification option causes Orca to provide justification and indentation information.

**ProgressBar Updates**

If the SpeakProgressBarUpdates setting is enabled, Orca periodically announces the status of progress bars. How often the announcement is made is determined by the value chosen as the Update interval spin. This setting is only available if the Speak ProgressBar Updates option is selected.

Use the RestrictProgressBarUpdates setting to control which progress bars should be spoken. The default value is Application. The following choices are available:
- All – Orca speaks updates for all progress bars regardless of where they are located
- Application – Orca speaks updates from progress bars in the active application even if they are not in the active window
- Window – Orca only speaks updates only for progress bars in the active window

**Say All By**

The Say All By setting specifies whether the Say All functionality of Orca speaks by sentence or line.

**Enabling Braille Preferences in Orca**

The Braille page enables you to customize various aspects about the use of Braille.
Note – Orca does not automatically start BRLTTY for you. You need to do this at boot time.

Enable Braille Support

Select the Enable Braille Support option to make use of a Braille display. By default, this option is enabled.

If BRLTTY is not running, Orca recovers gracefully and does not communicate with the Braille display. If you configure BRLTTY later, you need to restart Orca to use Braille.

Enable Braille Monitor

Orca’s Braille monitor provides an on-screen representation of what takes place on the Braille display. This feature is mostly for demonstration purposes, but is also useful for Orca developers who do not have access to a Braille display.

Enable Abbreviated Role Names

The Abbreviated Role Names check box determines the manner in which role names are displayed and can be used to help conserve real estate on the Braille display. For example, if a slider had focus and the Abbreviated Role Names option is selected, the word “slider” is abbreviated to “sldr”.

Disable End of Line Symbol

The Disable end of line symbol option tells Orca to not present the \$l string at the end of a line.

Contracted Braille

Orca supports contracted Braille through the Liblouis project. Refer to the Orca wiki to find additional information about setting up Liblouis with Orca.

Verbosity

The Verbosity options determine the amount of information that will be displayed in Braille in certain situations. For example, if the option is set to Verbose, keyboard shortcut and role name information is displayed. This information is not displayed in Brief mode.

Enable Selection Indicator

When you select text, Orca underlines the text on your Braille display with dots 7 and 8. If you prefer, you can change the indicator to Dot 7 or Dot 8, or not provide an indicator.
Enable Hyperlink Indicator

When you encounter a hyperlink, Orca underlines that text on your Braille display with dots 7 and 8. If you prefer, you can change the indicator to Dot 7 or Dot 8, or not provide an indicator.

Enabling Key Echo Preferences in Orca

The Key Echo page enables you to specify the behavior of Orca when pressing keys on the page and whether words are spoken as you complete them.

The key echo feature offers increased flexibility. For example, one user might choose to enable all the key echo options, while another might prefer to use word echo, but only have locking keys announced.

Enable Key Echo

The Enable Key Echo option provides specific settings for the key echo feature:
- Enable Alphanumeric And Punctuation Keys – Includes all alphabetical, numeric, and punctuation keys.
- Enable Modifier Keys – Includes Shift, Ctrl, and Alt keys.
- Enable Locking Keys – Includes Caps Lock, Scroll Lock, and Num Lock keys.
- Enable Function Keys – Includes function key groups.
- Enable Action Keys – Consists of keys that perform some logical action, such as Backspace, Return, and Tab.
- Enable Navigation Keys – Includes the four arrow keys as well as any key combination in which the Orca Modifier key is being held down. The latter is designed to prevent Orca from echoing flat review commands.
- Enable Non-spacing Diacritical Keys – These are the non printing keys that are used to generate accented letters.

Enable Echo by Character

The Enable Echo by Character option causes an echo of the characters you just typed. While echo by character seems similar to the key echo of alphanumeric and punctuation keys, there are important differences related to accented letters and other symbols for which there are no dedicated keys. Key echo announces the key that is just pressed and character echo announces the characters that was just inserted.

The Echo by Character option is always available, regardless of whether any of the other key echo options are selected.

Enable Echo by Word

The Enable Echo by Word option causes an echo of the word you just typed. The Echo by Word option is always available, regardless of whether any of the key echo options are selected.

Enable Echo by Sentence

The Enable Echo by Sentence option causes an echo of the sentence you just typed. The Enable Echo by Sentence control is always available regardless of whether any of the other key echo options are selected.

Enabling Magnifier Preferences in Orca

The Magnifier page enables you to enable or disable magnification and specify how magnification must be performed.
Enable Magnifier

The Enable Magnifier option causes Orca to provide magnification.

Zoomer Settings

Two zoomer GUI controls determine magnification characteristics:

- Scale Factor – Sets the magnification power from 1.0x to 16.0x. Fractional values are supported.
- Position – Sets the location and size of the magnifier window, and provides the following options:
  - Full Screen
  - Left Half
  - Right Half
  - Top Half
The default position is Full Screen. The Custom setting enables you to define the location of each edge of the zoom window. Units are in pixels.

**Border Settings**

The Enable Border option determines whether a window border is visible for the magnifier. The Border Size option determines the size of the border in pixels.

*Note* – These options are not available in Full Screen mode.

**Cursor Settings**

You can use Cursor Settings to customize the size and color of the magnifier’s cursor by using the following options:

- Enable Cursor – If enabled, a cursor is visible and the size and color options are available.
- Custom Size – If enabled, the mouse pointer appears larger than the normal size. The cursor size can be changed from the default value of 32 pixels.
- Custom Color – If enabled, you can apply a custom.

**Cross-hair Settings**

You can use Cross-hair Settings to customize the magnifier’s optional area-targeting cursor by using the following options:

- Enable Cross-hair – If selected, you can configure the clipping behavior, size, and color of the cross-hair.
- Enable Cross-hair Clip – If selected, the cross-hair is clipped (removed) in the area immediately surrounding the mouse pointer.
- Cross-hair Size – Sets the thickness of the cross-hair in pixels.
- Cross-hair Color – Enables you to apply a custom color.

**Color Settings**

Color Settings enables you to adjust the color of the magnified region by using the following options:

- Invert Colors – Creates a reverse or a negative-image effect.
- Brightness – Ranges from -1 (black or no brightness) to 1 (white or total brightness). 0 is normal or unchanged.
Contrast – Ranges from -1 (grey or no contrast) to 1 (1 is maximum contrast). 0 is normal or unchanged.

Tracking and Alignment Settings

Tracking and Alignment Settings control the tracking of the mouse cursor. The following tracking and alignment settings options are available:

- **Mouse Pointer** – Choose from the following options:
  - **Centered** – Keeps the mouse pointer at the center of the screen whenever possible. This is the default option.
  - **Proportional** – Positions the mouse pointer in the zoom window relative to its actual, unmagnified position. For instance, if the mouse pointer is 25% away from the left edge of the desktop, Orca positions the magnified mouse pointer 25% from the left edge of the zoom window.
  - **Push** – Moves the zoomer window to the least amount necessary to keep the mouse pointer on the screen.
  - **None** – Moving the mouse pointer has no impact on what the zoomer window displays.

- **Pointer Follows Zoomer** – This option is enabled by default. If the mouse pointer is not on the screen when you initially move the mouse, it is moved into the zoomer so that you can continue to see what you were working on. If your preferred mouse tracking mode is centered, the pointer is moved to the center; otherwise, it is moved to the item with focus.

- **Control And MenuItem** – These options control additional behavior of the magnifier.
  - **Centered** – When navigating using the keyboard, keep the focused dialog box control or menu item at the center of the screen whenever possible.
  - **Push** – When navigating using the keyboard, move the zoomer window to the least amount necessary to display the focused dialog box control or menu item. This is the default option.
  - **None** – Using the keyboard to navigate among dialog box controls and menu items will have no impact on what the zoomer window displays.
  - **Pointer Follows Focus** – If this option is enabled, the mouse pointer follows you as you navigate through menu items and move among controls in dialog boxes. This option is disabled by default.

- **Text Cursor** – These options control how the text cursor behaves.
  - **Centered** – As the text cursor moves, keep the cursor at the center of the screen whenever possible.
  - **Push** – As the text cursor moves, move the zoomer window to the least amount necessary to display it. This is the default option.
  - **None** – Moving the text cursor does not affect what the zoomer window displays.
Edge Margin – The edge margin determines how close the caret should be allowed to get to the edge of the screen before the zoomer window is pushed. The margin can range from 0 to 50%, with 50% being the equivalent of choosing centering. The default value is 0.

**Note** – This option is only available if Push is your text cursor tracking mode.

Advanced Settings – Clicking the Advanced Settings button located near the bottom of the Magnifier page displays the Advanced Settings dialog.

You can set the following options:
- Smoothing – Bilinear or none.
- Brightness – Red, Green, Blue: Individual controls for choosing different brightness levels for each color.
- Contrast – Red, Green, Blue: Individual controls for choosing customized contrast levels. These settings are not as significant as changes to brightness.
- Color Filtering – Enables you to pick one of the color blind filters available through \texttt{libcolorblind}.

\underline{Note} – To take advantage of this feature, you need to install \texttt{libcolorblind} and then rebuild \texttt{gnome-mag}.

- Multi-Monitor Settings - Source Display X Window System DISPLAY of what should be magnified. Written in the form \texttt{:0.n} where \texttt{n} is the number of the screen whose contents should be magnified.
- Multi-Monitor Settings - Target Display X Window System DISPLAY of where to put the zoomer window. Written in the form \texttt{:0.n} where \texttt{n} is the number of the screen where the zoomer window should appear.

\textbf{Enabling Key Bindings Preferences in Orca}

The Key Bindings page enables you to examine and modify the key bindings for Orca.
Orca Modifier Keys

The first control on the Key Bindings window enables you to determine which key or keys act as the Orca modifier. The Orca Modifier is the key that you press and hold in conjunction with other keys to give commands to Orca.

For desktop keyboards, the default Orca Modifier is the Insert key. For laptop keyboards, the default Orca Modifier is the Caps Lock key. See the Desktop keyboard layout and Laptop keyboard layout sections for the default values.

Note – You cannot modify the Orca modifier key by using the Configuration GUI.

Using the Key Bindings Table

The Key Bindings table provides a list of Orca operations and keys that are bound to them.
The Function column header provides the description of the Orca operation to be performed.

The Key Binding header is the primary way to invoke the function from the keyboard. If the function description includes the word "Orca", the Orca Modifier key should be held down along with the other indicated keys.

The Alternate header provides an alternate mechanism for invoking the function from the keyboard.

To modify either the Key Binding or the Alternate bindings, navigate to the cell and press Return. Then, press a key combination and press Return to confirm the new combination. The new keystroke is saved and the check box in the last column (the Modified column) indicates that the key binding has been modified.

To undo a modified keybinding, navigate to the modified column, deselect the checkbox, and click the Apply button, Alt+A.
Beneath the list of Orca keybindings, is a group of unbound commands. These commands are useful for some users but not needed by most users. Rather than appropriating a keystroke for such commands, these keys are unassigned.

You can assign a keystroke to any of these unbound commands as follows:

1. Press Return to edit the keybinding.
2. Press Delete or Backspace when prompted for the new keybinding.
3. Press Return to confirm.

**Enabling Pronunciation Preferences in Orca**

Sometimes your speech synthesizer might not correctly use words to convey or pronounce a particular string. For example, you might prefer to hear "laughing out loud" rather than "LOL," or a name or a technical term the synthesizer might mispronounce. On the pronunciation page, you can add, edit, and delete Orca's pronunciation dictionary entries. The pronunciation page
is part of the Application-specific Settings dialog that is started when you give a particular application focus and type Orca Modifier+Ctrl+Spacebar. You can therefore customize your entries as you need for each application that you use.

1. Press the New Entry button or Alt+N.
2. Type the text of the new entry and press Return to finish editing the actual string.
3. Move to the Replacement String column and press Return to begin editing.
4. Type the text that you would like to have spoken instead. Press Return to finish editing the replacement string.
To Edit an Existing Dictionary Entry

1. Move to the cell you want to edit and press Return to begin editing.

2. Make your changes and then press Return to finish editing.

To Delete an Existing Dictionary Entry

1. Move to the entry you want to delete.

2. Press the Delete button or Alt+D.

Text Attributes Page

Orca speaks known text attribute information about an object when you press Orca Modifier. The Text Attributes page of the configuration GUI enables you to customize the text attributes that Orca will present.
This page displays a text attribute list, where each row consists of four columns:

- The name of the text attribute.
- A checkbox that indicates whether this text attribute should be spoken.
- A checkbox that indicates whether this text attribute should be underlined on the Braille display.
- An editable Present unless string value. The value of the attribute will only be presented if it is not this value.

For example, by default, the underline text attribute has a value of none. If this attribute is selected and the user types Orca Modifier+F, and the text in question is not underlined, then this attribute is not spoken. If you always want this attribute to be spoken regardless of whether the text is underlined, select the attribute and clear the Present unless value.

Use the Reset button (Alt+R) to set the list values back to their initial state when the dialog is first displayed.
When you initially display the text attribute pane, all the selected attributes are displayed at the top of the list. They are given in the order that they will be spoken and used in Braille.

To select others or adjust the order, use the Adjust Selected Attributes buttons:

- Move to top (Alt+T) — Moves the selected attribute to the top of the list.
- Move up one (Alt+U) — Moves the selected attribute up one row.
- Move down one (Alt+D) — Moves the selected attribute down one row.
- Move to bottom (Alt+B) — Moves the selected attribute to the bottom of the list.

Use the Braille Indicator buttons to select the cell or cells to be used to indicate text which has at least one of the specified attributes. The choices are:

- None (default)
- Dot 7
- Dot 8
- Dots 7 and 8

Text attributes can also be set on an individual application basis. The Text Attribute pane is also part of the Application-specific Settings dialog box that is started when you give a particular application focus and type Orca Modifier+Ctrl+Spacebar.

**Using the Orca Keyboard Commands**

The Key Bindings page provides a complete list of the available keyboard commands of the Orca Configuration GUI. To open the Orca Configuration GUI, press Orca Modifier+Spacebar.

To enter Orca’s Learn mode while running Orca, press Orca Modifier+H. When in Learn mode, Orca will intercept all keyboard and Braille input events and indicate what the effect would be. To exit Learn mode, press the Escape key.

Orca provides additional commands for some applications, such as Firefox. To display the list of additional commands for an application, press Ctrl+Orca Modifier+Spacebar when that application has focus. The Orca Configuration GUI opens in the application-specific state, and additional commands appear in the Key Bindings page.

The GNOME Desktop also has built in keyboard commands to control the desktop and its applications. For more information about the GNOME shortcut keys, see Chapter 4, “Using the Keyboard to Navigate the Desktop”
Caution – The MouseKeys use the KP_Insert key to emulate a mouse button press. When enabled, MouseKeys can conflict with KP_Insert as the Orca modifier, resulting in a stuck Orca modifier key. As an alternative, you can use the laptop key bindings, which avoid the keypad for Orca commands. If you accidentally enable MouseKeys, you can disable it using the gnome-keyboard-properties application.

Using the Desktop Layout Commands

The following sections list the common Orca keyboard commands for desktop keyboards arranged by category.

Flat Review Keyboard Commands

The following table lists the keyboard shortcuts for the flat review commands when you use the desktop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numpad+7</td>
<td>Moves the flat review cursor to the previous line and reads it</td>
</tr>
<tr>
<td>Numpad+8</td>
<td>Reads the current line</td>
</tr>
<tr>
<td>Numpad+9</td>
<td>Moves the flat review cursor to the next line and reads it</td>
</tr>
<tr>
<td>Numpad+4</td>
<td>Move the flat review cursor to the previous word and reads it</td>
</tr>
<tr>
<td>Numpad+5</td>
<td>Reads the current word</td>
</tr>
<tr>
<td>Numpad+6</td>
<td>Moves the flat review cursor to the next word and reads it</td>
</tr>
<tr>
<td>Numpad+1</td>
<td>Moves the flat review cursor to the previous character and reads it</td>
</tr>
<tr>
<td>Numpad+2</td>
<td>Reads the current character</td>
</tr>
<tr>
<td>Numpad+3</td>
<td>Moves the flat review cursor to the next character and reads it</td>
</tr>
<tr>
<td>Numpad+Slash</td>
<td>Performs left mouse click at the location of the flat review cursor</td>
</tr>
<tr>
<td>Numpad+Asterisk</td>
<td>Performs right mouse click at the location of the flat review cursor</td>
</tr>
<tr>
<td>Numpad+Minus sign</td>
<td>Toggles between flat review and focus tracking modes</td>
</tr>
</tbody>
</table>
Note – These commands apply when working with objects as well as when working with text. For example, if the flat review cursor is positioned on a menubar, issuing the “read current line” command would speak the names of all visible menus. Similarly, issuing the “read next word” command would speak the object to the right of the flat review cursor on the same line, or move flat review to the next line if no more objects were found.

Bookmark Keyboard Commands

The following table lists the shortcut keys for the bookmark commands when you use the desktop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Insert+[1-6]</td>
<td>Assigns a bookmark to a numbered slot. If a bookmark already exists in the slot, the bookmark is replaced with a new one.</td>
</tr>
<tr>
<td>Insert+[1-6]</td>
<td>Goes to the position pointed to by the bookmark bound to this numbered slot.</td>
</tr>
<tr>
<td>Alt+Shift+[1-6]</td>
<td>Where Am I information for this bookmark relative to the current pointer location.</td>
</tr>
<tr>
<td>Insert+B and Insert+Shift+B</td>
<td>Moves between the given bookmarks for the given application or page.</td>
</tr>
<tr>
<td>Alt+Insert+B</td>
<td>Saves the defined bookmarks for the current application or page.</td>
</tr>
</tbody>
</table>

Miscellaneous Functions

The following table lists the shortcut keys for miscellaneous functions when you use the desktop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numpad+Plus sign</td>
<td>Say All command. Reads from the current position of the caret to the end of the document.</td>
</tr>
<tr>
<td>Numpad+Return</td>
<td>Where Am I command. Speaks information such as the title of the current application window, as well as the name of the control that currently has focus.</td>
</tr>
<tr>
<td>Insert+H</td>
<td>Enters Learn mode. Press Escape to exit.</td>
</tr>
<tr>
<td>Insert+F</td>
<td>Speaks font and attribute information for the current character.</td>
</tr>
<tr>
<td>Insert+Spacebar</td>
<td>Displays the Orca Configuration dialog box.</td>
</tr>
<tr>
<td>Insert+Ctrl+Spacebar</td>
<td>Reloads user settings and reinitializes services as necessary. Also, displays the Orca Configuration dialog box for the current application.</td>
</tr>
<tr>
<td>Insert+S</td>
<td>Toggles speech on and off.</td>
</tr>
</tbody>
</table>
Insert+F11 Toggles reading of tables, either by a single cell or a whole row.
Insert+Q Quits Orca.

### Debugging Keyboard Commands

The following table lists the shortcut keys for the debugging commands when you use the desktop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+Insert+Home</td>
<td>Reports information on the currently active script.</td>
</tr>
<tr>
<td></td>
<td>Note – To use the next three commands, Orca must be started from a virtual</td>
</tr>
<tr>
<td></td>
<td>console or through the <code>gnome- terminal</code>. Output is sent to the console only</td>
</tr>
<tr>
<td></td>
<td>and not to speech or Braille.</td>
</tr>
<tr>
<td>Ctrl+Alt+Insert+End</td>
<td>Prints a debug list of all the known applications to the console where Orca is running.</td>
</tr>
<tr>
<td>Ctrl+Alt+Insert+Page Up</td>
<td>Prints debug information about the ancestry of the object with focus.</td>
</tr>
<tr>
<td>Ctrl+Alt+Insert+Page Down</td>
<td>Prints debug information about the hierarchy of the application with focus.</td>
</tr>
</tbody>
</table>

### Using the Laptop Layout Commands

Following is a list of common Orca keyboard commands for laptop keyboards arranged by category.

#### Flat Review Keyboard Commands

The following table lists the keyboard shortcuts for the flat review commands when you use the Laptop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caps Lock+U</td>
<td>Moves the flat review cursor to the previous line and reads it. Double-click to move flat review to the top of the current window.</td>
</tr>
<tr>
<td>Caps_Lock+I</td>
<td>Reads the current line. Double-click to read the current line with formatting and capitalization details.</td>
</tr>
<tr>
<td>Caps Lock+O</td>
<td>Moves the flat review cursor to the next line and reads it. Double-click to move flat review to the bottom of the current window.</td>
</tr>
<tr>
<td>Caps Lock+J</td>
<td>Moves the flat review cursor to the previous word and reads it. Double-click to move flat review to the word above the current word.</td>
</tr>
</tbody>
</table>
Keys | Function
--- | ---
Caps Lock+K | Reads the current word. Double-click to spell the word. Triple-click to hear the word spelled phonetically.
Caps Lock+L | Moves the flat review cursor to the next word and reads it. Double-click to move flat review to the word below the current word.
Caps Lock+M | Moves the flat review cursor to the previous character and reads it. Double-click to move flat review to the end of the current line.
Caps Lock+Comma | Reads the current character. Double-click to pronounce the character phonetically if it is a letter.
Caps Lock+Period | Moves the flat review cursor to the next character and reads it.
Caps Lock+7 | Performs a left mouse click at the location of the flat review cursor.
Caps Lock+8 | Performs a right mouse click at the location of the flat review cursor.
Caps Lock+p | Toggles between flat review and focus tracking mode.

These commands apply when working with objects as well as when working with text. For example, if the flat review cursor is positioned on a menubar, issuing the “read current line” command speaks the names of all visible menus. Similarly, issuing the “read next word” command speaks the object to the right of the flat review cursor on the same line, or move flat review to the next line if no more objects were found.

**Bookmark Keyboard Commands**

The following table lists the keyboard shortcuts for the bookmark commands when you use the laptop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Caps Lock+[1-6]</td>
<td>Adds a bookmark to the numbered slot. If a bookmark already exists for the slot, it is replaced with the new one.</td>
</tr>
<tr>
<td>Caps Lock+[1-6]</td>
<td>Goes to the position pointed to by the bookmark bound to this numbered slot.</td>
</tr>
<tr>
<td>Alt+Shift+[1-6]</td>
<td>Where Am I information for this bookmark relative to the current pointer location.</td>
</tr>
<tr>
<td>Caps Lock+B</td>
<td>Moves between the given bookmarks for the given application or page.</td>
</tr>
<tr>
<td>Alt+Caps Lock+B</td>
<td>Saves the defined bookmarks for the current application or page.</td>
</tr>
</tbody>
</table>
## Miscellaneous Keyboard Commands

The following table lists the shortcut keys for the miscellaneous functions when you use the Laptop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caps Lock+Semicolon</td>
<td>Say All command. Reads from the current position of the caret to the end of the document.</td>
</tr>
<tr>
<td>Caps Lock+Return</td>
<td>Where Am I command. Speaks information such as the title of the current application window, as well as the name of the control that currently has focus.</td>
</tr>
<tr>
<td>Caps Lock+H</td>
<td>Enters Learn mode. Press Escape to exit.</td>
</tr>
<tr>
<td>Caps Lock+F</td>
<td>Speaks font and attribute information for the current character.</td>
</tr>
<tr>
<td>Caps Lock+Spacebar</td>
<td>Starts the Orca Configuration dialog.</td>
</tr>
<tr>
<td>Caps Lock+Ctrl+Spacebar</td>
<td>Reloads user settings and reinitialize services as necessary. It also starts the Orca Configuration dialog for the current application.</td>
</tr>
<tr>
<td>Caps Lock+S</td>
<td>Toggles speech on and off.</td>
</tr>
<tr>
<td>Caps Lock + F11</td>
<td>Toggles reading of tables, either by single cell or whole row.</td>
</tr>
<tr>
<td>Caps Lock + Q</td>
<td>Quits Orca.</td>
</tr>
</tbody>
</table>

## Debugging Keyboard Commands

The following table lists the shortcut keys for the debugging commands when you use the Laptop layout.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caps Lock+Alt+Ctrl+Home</td>
<td>Reports information on the currently active script.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> – In order for the next three commands to be of use, Orca needs to be started from a virtual console or using the <code>gnome-terminal</code>. The output is sent to the console only and not sent to speech or Braille.</td>
</tr>
<tr>
<td>Caps Lock+Alt+Ctrl+End</td>
<td>Prints a debug listing all known applications to the console where Orca is running.</td>
</tr>
<tr>
<td>Caps Lock+Alt+Ctrl+Page Up</td>
<td>Prints debug information about the ancestry of the object with focus.</td>
</tr>
<tr>
<td>Caps Lock+Alt+Ctrl+Page Down</td>
<td>Prints debug information about the object hierarchy of the application with focus.</td>
</tr>
</tbody>
</table>
Application-Specific Information

Orca is designed to work with applications and toolkits that support the Assistive Technology Service Provider Interface (AT-SPI). These applications include the Oracle Solaris Desktop and its bundled applications: OpenOffice, Firefox, and the Java platform.

▼ Making Application-Specific Settings

1 To customize the settings for a particular application, start that application.

2 Ensure that the application has focus and then press Orca Modifier+Ctrl+Spacebar.

A tabbed dialog window similar to the Orca Configuration dialog is displayed with the following differences:

- No initial General pane.
- The Speech System and Speech Synthesizer options on the Speech pane are inactive.
- Any application-specific key bindings appear at the top of the list on the Key Bindings pane.
- A new application-specific settings pane might appear at the end of the standard set of tabs. Press the End key from the tab list to go directly to the right-most tab.

Adjust your application-specific settings. For example, you might have Key Echo disabled generally in Orca but would like to specifically have it enabled for the GNOME Calculator application.

When you have customized your application settings, click OK.

These settings are written to your `~/.orca/app-settings` directory in a file called `APPNAME.py`, where `APPNAME` is the name of the application.

Orca automatically writes these files. The contents of the file are overwriten each time you change your application settings for that application.

To retain any application-specific settings or code, copy them to a file called `~/.orca/app-settings/APPNAME-customizations.py`. This file is automatically read when the settings for the application are loaded.

**Note** – If you adjust one or more application-specific key bindings, the new values will not take effect until you click OK. The workaround is to either restart Orca, or to press Alt+Tab to move to another application and then press Alt+Tab to return to the application for which you have just changed the key bindings.
To Enable Braille

Orca uses BRLTTY for Braille support. BRLTTY is used to access the text mode console content. On a typical Braille-enabled installation of Oracle Solaris, BRLTTY is already running and provides access to text consoles. When Orca starts, it connects to BRLTTY. If you switch from a text console to your X Windows session, your Braille display automatically follows and displays the content that Orca is presenting to you.

Orca currently works best with BRLTTY v3.8 or better and also works well with BRLTTY v3.7.2. This document provides information about using Orca with BRLTTY 3.8.

Troubleshooting Orca

This section describes troubleshooting topics in Orca.

Desktop Is Unresponsive

1. Press Alt+F2 or Meta+R to open the Run dialog.
2. Type orca and press Return to start a new instance of Orca.
   
   This will force any existing Orca processes to exit and then restart Orca.
   
   Sometimes, this step might cause the desktop to hang, which is usually because of an ill-behaved application.

   Note – If you cannot get to a terminal window, try pressing Ctrl+Alt+Backspace, which shuts down the X Window System server.

   This action should return you to the login screen.

Disabling the Screensaver

Before you use Screen Reader and Magnifier, you must disable the screensaver.

1. Choose System → Preferences → Screensaver.
2. In the Display Modes tabbed section, deselect the Lock Screen After option.
3. In the Mode list, select Disable Screen Saver.
5. Choose File → Quit to close the Screensaver Preferences dialog box.
To Change the PDF Viewer Application

To change the PDF viewer application for the Oracle Solaris Desktop to another PDF viewer application, perform the following steps:

1. In the File Manager, select the PDF you want to open.
2. Choose File → Open with Other Application
3. In the dialog that opens, choose the PDF reader application of your choice.
4. If required, select the Remember This Application For PDF Document Files option. This will use the selected option to open all PDF files in the future.
This chapter describes how to configure the mouse and keyboard to make these devices accessible to more users.

Configuring the Mouse

Use the Mouse preference tool to configure the mouse. To open the Mouse preference tool, choose System → Preferences → Mouse. The Mouse Preferences dialog is displayed.

Configuring the Behavior of the Mouse

This section describes how to modify the behavior of the mouse.

▼ To Configure the Mouse for Left-Handed Use

1  Choose System → Preferences → Mouse.

2  Click the General tab in the Mouse Preferences dialog.

3  Select the Left-handed option in the Mouse Orientation section.

▼ To Configure the Double-Click Behavior

If you have difficulty double-clicking, you can increase the period of time that the system allows to elapse between the first click and the second click of a double-click.

1  Choose System → Preferences → Mouse.

2  Click the General tab in the Mouse Preferences dialog.
3 Use the Double-Click Timeout slider to specify the timeout in seconds that the system allows between the two clicks of a double-click.

Moving the slider to the right will increase the timeout interval. Similarly, moving the slider to the left will decrease the timeout interval.

4 Double-click the light bulb to the right of the slider to test the setting.

If you perform the two clicks of the double-click within the timeout specified, the light bulb lights up fully to display a yellow glow around the bulb. If you do not double-click within the timeout specified, the light bulb does not light fully. You should increase the timeout setting and try again. When the light bulb lights, the timeout setting is suitable for your needs.

▼ To Change the Size of the Pointer

1 Choose System → Preferences → Appearances.

2 Click the Customize button to open the Customize Theme dialog.

3 In the Customize Theme dialog, select the Pointers tab.

4 In the Pointer tab, select a pointer theme that supports resizing, for example, DMZ-White, redglass, or whiteglass.

5 Drag the Size slider to increase or decrease the size of the mouse pointer.

6 Close the dialog box.

▼ To Locate the Mouse Pointer

If you have difficulty locating the mouse pointer on the screen, you can enable an option to highlight the pointer when you press the Control key. To enable this option, perform the following steps:

1 Click on the General tab in the Mouse Preferences dialog.

2 Select the Show Position of Pointer When The Control Key is Pressed option present in the Locate Pointer section.

▼ To Configure the Speed and Sensitivity of the Mouse

1 Click on the General tab in the Mouse Preferences dialog.

2 Configure the following options in the Pointer Speed section:
Acceleration

Use the slider to specify the speed at which the mouse pointer moves around the screen when you move your mouse.

If you select a low setting, the mouse pointer moves at a speed similar to the speed at which you are physically moving the mouse. This means that you need to physically move the mouse larger distances to cover the screen area. If you select a high setting, the mouse pointer moves at a faster speed than the speed at which you physically move the mouse. This means that you need to physically move the mouse small distances to cover the screen area.

Sensitivity

Use the slider to specify how sensitive the mouse pointer is to movements of your mouse.

Threshold

This option is present in the Drag and Drop section.

Use the slider to specify the distance that you must move an item before the system interprets the move action as a drag-and-drop action.

Configuring the Cursor

The following section describes how to modify the display characteristics of the cursor.

To Stop Cursor Blinking

1. Click System, then choose Preferences → Keyboard to start the Keyboard preference tool.

2. In the General tabbed section, deselect the Cursor Blinks in Text Fields option.

Using Mouse Tweaks

Mouse Tweaks is a collection of accessibility enhancements for pointing devices. The Mouse Tweaks package provides the functions offered by the Accessibility tab of the Mouse preference tool. It also contains two panel applets related to the mouse accessibility. More particularly:

- Enables users to perform a secondary click by doing a click-and-hold of the primary mouse button.
- Offers a way to perform the various clicks without using any hardware button. In this context, the Dwell Click panel applet can be used to choose what click type to perform.
To Simulate a Secondary Click
A secondary or right-click can be issued by using the primary button and keeping it held down for a specified delay.

Issuing a Dwell Click
A click can be issued by having the mouse pointer dwell in a given spot for a specified delay. In this mode, the click-type is determined by the ClickType window, or by the direction in which the user moves the mouse after the dwell time has elapsed. The click-type can be single, double, drag or right.

Most mouse-related accessibility options can be found by using System → Preferences → Mouse and selecting the Accessibility tab.

To Use the Keyboard to Emulate the Mouse
If you have difficulty using a mouse, you can use the keyboard to emulate mouse functions. See “Configuring an Accessible Keyboard” on page 50 for more information.

Configuring an Accessible Keyboard
Use the Keyboard preference tool to configure the keyboard accessibility options. To open the Keyboard preference tool, choose System → Preferences → Keyboard. Select the Accessibility tab to display the accessibility options.

The Accessibility tabbed section provides the following options:

- Allow to turn accessibility features on and off from the keyboard (Alt + A) – Determines whether keyboard accessibility functions can be turned on or off with a key command.
- Simulate simultaneous keypress (Alt + S) – Allows multiple shift (or other) keys to be entered individually but processed as a single combination keystroke. This keyboard accessibility technique is known as “sticky keys”.
- Disable sticky keys if two keys are pressed together (Alt + B) – Automatically exit the sticky keys mode if any key combination is pressed normally (that is, at the same time instead of pressed individually).
- Only accept long keypress (Alt + O) – In this mode, keys must be pressed for a given length of time before they are accepted as input. This accessibility technique is also known as “slow keys”. This portion of the Accessibility tabbed section also supplies a delay slider (Alt + D) to indicate the press-down delay before the key is accepted as input.
Ignore fast duplicate keypress (Alt+l) – In this mode, successive entry of the same key will only have a single instance of that key accepted as input. This accessibility technique is also known as “bounce keys”. This portion of the Accessibility tabbed section also supplies a delay slider (Alt+E) to indicate the press-down delay before successive keys are ignored.

Configuring a Keyboard-Based Mouse

Use the Keyboard preference tool to configure the keyboard to simulate a mouse. To open the Keyboard preference tool, choose System → Preferences → Keyboard. Select the Mouse Keys tab to access the Mouse Keys options.

- Allow to control the pointer using the keyboard (Alt+A) – Determines whether the keyboard can be used to control the mouse pointer.
- Acceleration (Alt+C) – Determines how quickly mouse motion will accelerate when keyboard directional keys are pressed.
- Speed (Alt+S) – Determines how quickly the mouse pointer will move when keyboard directional keys are pressed.
- Delay (Alt+D) – Determines how much (or whether) keypress may be dampened or ignored when keyboard directional keys are pressed.

Using Dasher

Dasher is an information-efficient text-entry interface, driven by natural continuous pointing gestures. Dasher is a competitive text-entry system wherever a full-size keyboard cannot be used, for example on a palmtop or wearable computer, or when operating any computer one-handed (by joystick, touchscreen or mouse) or zero-handed (for example, by head-mouse or eye-tracker).

To Install Dasher

Dasher is not installed by default on the Oracle Solaris Desktop. To install Dasher from the Oracle Solaris package repository.

- Ensure you are connected to the internet, then perform the following steps:
  - From a terminal window:
    - Type the following command:
      ```
      sudo pkg install dasher
      ```
b. Provide your password if prompted.

- Through the Package Manager application:
  a. Choose System → Administration → Package Manager.
  b. Search for the dasher package.
  c. Select the dasher package.
  d. Install the dasher package.

▼ To Start Dasher

- You can start the Dasher in any of the following ways.
  - Press Alt+F2 or Meta+R to display the Run dialog, type dasher and press Enter.
  - Choose Applications → Accessories → Terminal and execute dasher.
  - Press Alt+F1 and select Applications → Universal Access → Dasher.
Using the Keyboard to Navigate the Desktop

This chapter describes how to navigate the Oracle Solaris Desktop from the keyboard only. Users who have difficulty using a mouse or other pointing device can navigate and use the desktop from the keyboard.

Introduction to Keyboard Navigation

This section describes the essential keyboard shortcuts to enable you to navigate the desktop from the keyboard.

You can customize some of the keyboard shortcuts that are described in this chapter. The text indicates the shortcuts that you can customize. See “Customizing Your Keyboard Shortcuts” on page 76 for information about how to customize keyboard shortcuts.

Essential Keyboard Shortcuts

The following table lists the essential keyboard shortcuts that you can use to navigate the desktop. The keyboard shortcuts that you use to navigate specific elements and controls are described in the appropriate sections of this chapter.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Esc</td>
<td>Grants access to the Applications, Places and System menubar items.</td>
</tr>
<tr>
<td>Alt+F2 and Meta+R</td>
<td>Displays the Run Application dialog, where you can type terminal commands with or without parameters. If a file needs to be passed as one of these parameters, use the Run With File button to locate the necessary file.</td>
</tr>
<tr>
<td>Tab</td>
<td>Gives focus to the next element or control.</td>
</tr>
</tbody>
</table>
### Keys Function

**Shift+Tab**  
Reverses the navigation direction and gives focus to the previous element or control. In general, the Shift key reverses the navigation direction.

**Ctrl+Tab**  
Gives focus to the next element or control, if the Tab key has a specific purpose in a control. For example, if you press Tab in a text box, the system inserts a tab space.

To give focus to the previous element or control, press Shift+Ctrl+Tab.

**Alt+Tab and Shift+Alt+Tab**  
Switches between currently running applications. If you have multiple programs running, use Alt+Tab to cycle forward through the applications and Shift+Alt+Tab to cycle backwards.

**Arrow keys**  
Navigates within an element or control.

**Spacebar**  
Activates the element or control that has focus. For example, if the current control is a button, this action is the equivalent of clicking the button with a mouse.

**Esc**  
Closes a window, menu, or drawer.

**F7**  
Switches to caret navigation mode. Caret navigation mode enables you to use the keyboard to select text. For more information about caret navigation mode, see “Navigating HTML Content in Caret Navigation Mode” on page 65.

### Global Keyboard Shortcuts

The following table lists the keyboard shortcuts that you can use from any part of the Oracle Solaris Desktop.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F1</td>
<td>Opens the Main Applications Menu. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Alt+F2 and Meta+R</td>
<td>Opens the Run Applications dialog. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Print Screen</td>
<td>Starts the screenshot application and takes a screenshot of the entire screen. You can customize this keyboard shortcut.</td>
</tr>
</tbody>
</table>
Navigating the Desktop Background

The desktop background is the part of the Oracle Solaris Desktop where there are no interface items or applications, such as panels and windows. The following table lists the keyboard shortcuts that you can use to navigate the desktop background and the desktop background objects. A desktop background object is an icon on the desktop background that you can use to open files, folders, or applications.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Print Screen</td>
<td>Starts the screenshot application and takes a screenshot of the window that currently has focus. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>F1</td>
<td>If the focused element is an application window or dialog, this keyboard shortcut opens the Help for the application.</td>
</tr>
<tr>
<td>Ctrl+F1</td>
<td>If the focused element is a panel or application window, this keyboard shortcut switches the display of tooltips for the window or panel objects on and off.</td>
</tr>
<tr>
<td>Shift+F10</td>
<td>Opens a pop-up menu for the element that has focus, if a pop-up menu exists.</td>
</tr>
<tr>
<td>Ctrl+Alt+D</td>
<td>Temporarily hides all windows and gives focus to the desktop background. To restore the windows, press Ctrl+Alt+D again.</td>
</tr>
<tr>
<td></td>
<td>You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Ctrl+Alt+Tab</td>
<td>Displays a pop-up window with icons that represent the desktop background and the panels. Press and hold Ctrl+Alt and continue to press Tab to switch the focus between the desktop background and the panels.</td>
</tr>
<tr>
<td></td>
<td>You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>When the desktop background or a desktop background object has focus, gives focus to a neighboring desktop background object.</td>
</tr>
<tr>
<td>A sequence of characters that matches the first n characters of a desktop background object name.</td>
<td>When the desktop background has focus, gives focus to the desktop background object whose name starts with the specified sequence of characters.</td>
</tr>
<tr>
<td>F2</td>
<td>Renames the desktop background object that has focus.</td>
</tr>
</tbody>
</table>

Chapter 4 • Using the Keyboard to Navigate the Desktop 55
Navigating Panels

A panel is an area from which you can run special programs, applications, and panel applications. The most common panel is the panel that stretches the full width of the bottom edge of the desktop. The following table lists the keyboard shortcuts that you can use to navigate panels and panel objects.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift+F10</td>
<td>Opens the pop-up menu for the desktop background object that has focus.</td>
</tr>
<tr>
<td>Ctrl+F10</td>
<td>Opens the Desktop Background menu.</td>
</tr>
<tr>
<td>Ctrl+Alt+Tab</td>
<td>Gives focus to a panel. This keyboard shortcut displays a pop-up window with icons that represent the desktop background, panels, and drawers. Press and hold Ctrl+Alt and continue to press Tab to switch the focus between the desktop background, panels, and drawers. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Tab</td>
<td>Gives focus to the next object on the panel.</td>
</tr>
<tr>
<td>F10</td>
<td>Opens the Applications menu when the focus is on the top panel.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Activates a panel object, for example, open a menu or start a launcher.</td>
</tr>
<tr>
<td>Shift+F10</td>
<td>Opens the panel object pop-up menu.</td>
</tr>
<tr>
<td>Ctrl+F10</td>
<td>Opens the panel pop-up menu.</td>
</tr>
</tbody>
</table>

▼ To Move a Panel Object

You can move a focused panel object to a different location on a panel or drawer, or you can move the object to the next panel.

1. **Press Tab to give focus to the object.**
2. **Press Shift+F10 to open the panel object pop-up menu.**
3. **Use the arrow keys to select the Move menu item.**
4 Use the keyboard shortcuts that are listed in the following table to perform the move operation.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Moves the object left and right on a horizontal panel or up and down on a vertical panel.</td>
</tr>
<tr>
<td>Shift+arrow keys</td>
<td>Moves the object and pushes any object that you encounter in front of the object.</td>
</tr>
<tr>
<td>Ctrl+arrow keys</td>
<td>Moves the object and swap position with any objects that you encounter in the move.</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves the object to the next panel.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Completes the move operation.</td>
</tr>
</tbody>
</table>

Example 4–1 Geyes Examples

The following examples demonstrate the effect of different move operations on the objects in a panel using the Geyes application.

<table>
<thead>
<tr>
<th>Illustration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Shows a panel with three panel objects before a move operation takes place.</td>
</tr>
<tr>
<td></td>
<td>Shows the effect of using the arrow keys to move the Geyes panel application on the panel. You can use the arrow keys to move the panel application left or right until you meet the next panel object.</td>
</tr>
<tr>
<td></td>
<td>Shows the effect of using Shift+arrow keys to move the Geyes panel application on the panel. You can use the Shift+arrow keys to push the Volume Control and Help panel objects ahead of the object that you are moving.</td>
</tr>
<tr>
<td></td>
<td>Shows the effect of using Ctrl+arrow keys to move the Geyes panel application on the panel. You can use Ctrl+arrow keys to swap position with the Volume Control and Help panel objects as you meet the objects.</td>
</tr>
</tbody>
</table>

Navigating Drawers

A drawer is a collapsible extension of a panel. The following table lists the keyboard shortcuts that you can use to navigate into and out of drawers. When you open a drawer, you can navigate the contents of the drawer in the same way as you navigate a panel. See “Navigating Panels” on page 56 for information about how to navigate a panel.
Navigating Panels

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spacebar</td>
<td></td>
</tr>
<tr>
<td>Arrow keys</td>
<td></td>
</tr>
<tr>
<td>Esc</td>
<td>Opens or close the drawer that has focus.</td>
</tr>
<tr>
<td></td>
<td>Navigates into the drawer that has focus.</td>
</tr>
<tr>
<td></td>
<td>Closes the drawer and gives focus to the</td>
</tr>
<tr>
<td></td>
<td>drawer object on the panel.</td>
</tr>
</tbody>
</table>

Navigating Menus on Panels

The following table lists the keyboard shortcuts that you can use to navigate menus on panels.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>spacebar</td>
<td></td>
</tr>
<tr>
<td>arrow keys</td>
<td></td>
</tr>
<tr>
<td>spacebar</td>
<td></td>
</tr>
<tr>
<td>Shift+F10</td>
<td></td>
</tr>
<tr>
<td>Esc</td>
<td>Opens the menu that has focus.</td>
</tr>
<tr>
<td></td>
<td>Navigates the menu.</td>
</tr>
<tr>
<td></td>
<td>Selects a menu item.</td>
</tr>
<tr>
<td></td>
<td>Opens the pop-up menu associated with a menu</td>
</tr>
<tr>
<td></td>
<td>item, if one exists.</td>
</tr>
<tr>
<td></td>
<td>Closes a menu.</td>
</tr>
</tbody>
</table>

Navigating Panel Applications

A panel application is a small application that resides on a panel. You can navigate to all panel applications and open the panel application pop-up menu from the keyboard. However, if the panel application does not contain controls that you can give focus to, you cannot navigate the controls in the panel application. The following table lists the keyboard shortcuts that you can use to navigate panel applications.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spacebar</td>
<td></td>
</tr>
<tr>
<td>Arrow keys</td>
<td></td>
</tr>
<tr>
<td>Shift+F10</td>
<td></td>
</tr>
</tbody>
</table>

Activates the panel application control that has focus, if applicable. Not all panel applications contain controls that you can activate. If the panel application does not contain a control that you can activate, the Spacebar does nothing.

Navigates the controls on the panel application.

Opens the panel application pop-up menu. To navigate the menu, use the standard keyboard shortcuts for navigating menus. See "Navigating Menus" on page 66 for information about how to navigate menus.
Navigating Your Workspaces

A workspace is a discrete area in which you can work. You can have many workspaces on your desktop and you can switch from one workspace to another. Each workspace can contain different windows and processes. The following table lists the keyboard shortcuts that you can use to navigate workspaces.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+arrow keys</td>
<td>Gives focus to the next or previous workspace. This keyboard shortcut displays a pop-up window with icons that represent the workspaces. Press and hold Ctrl+Alt and continue to press the arrow keys to switch the focus between the workspaces. You can customize this keyboard shortcut.</td>
</tr>
<tr>
<td>Shift+Ctrl+Alt+arrow keys</td>
<td>Moves the window that has focus to the next or previous workspace. You can customize this keyboard shortcut.</td>
</tr>
</tbody>
</table>

Navigating Windows

The following sections describe the keyboard shortcuts that you can use to navigate windows. A window is a rectangular frame on your screen that displays an application.

Note – You can customize all of the keyboard shortcuts that are associated with navigating windows. See “Navigating Your Workspaces” on page 59 for more information.

Giving Focus to a Window

Before you can use or modify a window, you must give focus to the window. The following table lists the keyboard shortcuts that you can use to give focus to a window.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Tab</td>
<td>Displays a pop-up window with icons that represent each window. Press and hold Alt and continue to press Tab to move through the windows until you reach the window to which you want to give focus.</td>
</tr>
<tr>
<td>Alt+Esc</td>
<td>Raises each window in turn until you reach the window to which you want to give focus.</td>
</tr>
</tbody>
</table>
### Controlling a Window

When a window has focus, you can perform various actions on the window. The following table lists the keyboard shortcuts that you can use to control the window that has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Spacebar</td>
<td>Opens the Window menu.</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Closes the window.</td>
</tr>
<tr>
<td>Open</td>
<td>Minimizes the window.</td>
</tr>
<tr>
<td>Alt+F10</td>
<td>Maximizes the window.</td>
</tr>
<tr>
<td>Alt+F5</td>
<td>Restores a maximized window to the original size of the window.</td>
</tr>
</tbody>
</table>

### Moving a Window

When a window has focus, you can move the window around the screen. The following table lists the keyboard shortcuts that you can use to move a window.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F7</td>
<td>Starts the move operation. The mouse pointer changes to a cross.</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Moves the window 10 pixels at a time in the direction of the arrow key.</td>
</tr>
<tr>
<td>Ctrl+Arrow keys</td>
<td>Moves the window one pixel at a time in the direction of the arrow key.</td>
</tr>
<tr>
<td>Shift+Arrow keys</td>
<td>Moves the window in the direction of the arrow key to align it with the edge of the nearest window, panel, or screen edge.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Completes the move operation and leaves the window in the current position.</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancels the move operation and restores the window to the original position.</td>
</tr>
</tbody>
</table>
### Resizing a Window

When a window has focus, you can increase or decrease the size of the window. The following table lists the keyboard shortcuts that you can use to resize the window that has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F8</td>
<td>Starts the resize operation.</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Resizes the window in the direction of the arrow keys.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Completes the resize operation and leaves the window at the current size.</td>
</tr>
<tr>
<td>Esc</td>
<td>Cancels the resize operation and restores the window to the original size.</td>
</tr>
</tbody>
</table>

### Navigating Paned Windows

A paned window is a window that is split into two or more panes. The Help browser and the File Manager are examples of applications that use paned windows.

The following table describes the keyboard shortcuts that you can use to navigate windows with panes.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Gives focus to the next pane. The system gives focus to the control that last had focus in the pane.</td>
</tr>
<tr>
<td>F8</td>
<td>Gives focus to the first resize handle in the window. The resize handle is displayed between the panes and enables you to resize the panes. Press F8 again to give focus to the next resize handle.</td>
</tr>
</tbody>
</table>

When the resize handle has focus, you can use the keyboard shortcuts that are listed in the following table to modify the paned window.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Moves the resize handle by a small amount.</td>
</tr>
<tr>
<td>Ctrl+Arrow keys</td>
<td>Moves the resize handle by a large amount.</td>
</tr>
<tr>
<td>Keys</td>
<td>Function</td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>Home</td>
<td>Reduces the size of the pane to the left of the resize handle for vertical panes, or above the resize handle for horizontal panes, to the minimum size allowed.</td>
</tr>
<tr>
<td>End</td>
<td>Increases the size of the pane to the left of the resize handle for vertical panes, or above the resize handle for horizontal panes, to the maximum size allowed.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Sets the position of the resize handle and returns the focus to the last control that had focus.</td>
</tr>
<tr>
<td>Esc</td>
<td>Resets the position of the resize handle to the original position and returns the focus to the last control that had focus.</td>
</tr>
</tbody>
</table>

**Navigating Applications**

An application is any program, utility, or other software package that you run on your desktop. Applications comprise the following standard user interface components:

- **Windows** A window is a rectangular frame on your screen that displays an application. See "Navigating Windows" on page 59 for information about how to navigate windows.
- **Dialogs** A dialog is a pop-up window in which you enter information or commands. See “Essential Keyboard Shortcuts for Navigating Dialogs" on page 63 for information about how to navigate dialogs.
- **Controls** A control is an instrument that you use to operate or guide the user interface. For example, buttons, check boxes, menus, and text boxes are controls. See “Navigating Standard Elements and Controls” on page 66 for detailed information about how to navigate the different types of controls that are available.

This section of the manual describes the essential keyboard shortcuts that you can use to start using applications and dialogs.

**Essential Keyboard Shortcuts for Navigating Applications**

Because you can use many applications in the Oracle Solaris Desktop, this manual does not describe the keyboard shortcuts that you can use to navigate all of the different applications. However, some basic keyboard shortcuts are common to all applications. Access keys also provide an efficient way to navigate an application from the keyboard. An access key is
identified by an underlined letter on a menu or control. In some cases, you must press Alt in combination with the access key to perform an action.

The following table lists the essential keyboard shortcuts that you can use to navigate applications.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F10</td>
<td>Opens the first menu on the application menubar.</td>
</tr>
<tr>
<td>Alt+Access key</td>
<td>Opens the menu that is associated with the access key.</td>
</tr>
<tr>
<td>Access keys</td>
<td>Selects the menu item that is associated with the access key.</td>
</tr>
<tr>
<td>Left arrow and right arrow</td>
<td>Switches focus between the menus on the menubar.</td>
</tr>
<tr>
<td>Up arrow and down arrow</td>
<td>Moves focus into a menu.</td>
</tr>
<tr>
<td>Esc</td>
<td>Closes the open menus and give focus to the control that had focus before the menubar.</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Opens the file selector dialog.</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Opens the Save dialog.</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Opens a Location dialog to enable you to type the name of the file that you want to open or save.</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Opens a Print dialog, if available.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copies highlighted text to the global, application-spanning clipboard.</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cuts highlighted text to the global, application-spanning clipboard.</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Pastes text from the global, application-spanning clipboard to the current cursor position.</td>
</tr>
</tbody>
</table>

**Essential Keyboard Shortcuts for Navigating Dialogs**

The following table lists the essential keyboard shortcuts that you can use to navigate dialogs.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+access key</td>
<td>Activates or select a control.</td>
</tr>
<tr>
<td>Tab</td>
<td>Gives focus to the next control.</td>
</tr>
</tbody>
</table>
Navigating the File Manager

The File Manager window contains several components and different keyboard shortcuts are defined to navigate each component.

Navigating Folders

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Selects the next or previous file or folder in the direction of the arrow key.</td>
</tr>
<tr>
<td>Ctrl+arrow keys</td>
<td>Gives focus to the next or previous file or folder but does not select the item. This allows multiple, non-contiguous blocks of files to be selected.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Opens the focused file or folder.</td>
</tr>
<tr>
<td>A sequence of characters that matches the first ( n ) characters of a filename.</td>
<td>Selects the first file or folder that starts with the specified sequence of characters.</td>
</tr>
<tr>
<td>Home</td>
<td>Selects the first file or folder within the current folder.</td>
</tr>
<tr>
<td>End</td>
<td>Selects the last file or folder within the current folder.</td>
</tr>
<tr>
<td>Backspace</td>
<td>Opens the current folder’s parent folder.</td>
</tr>
<tr>
<td>Shift+F10</td>
<td>Opens a file or folder pop-up menu.</td>
</tr>
<tr>
<td>Ctrl+F10</td>
<td>Opens the pop-up menu of the enclosing folder.</td>
</tr>
</tbody>
</table>
Navigating the Side Pane

The following table describes the keyboard shortcuts that enable you to navigate the File Manager side pane in general. The side pane is displayed on the left side of the File Manager window.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Switches focus between the side pane and the view pane.</td>
</tr>
<tr>
<td>Shift+F10</td>
<td>Opens the side pane pop-up menu.</td>
</tr>
</tbody>
</table>

Navigating HTML Content in Caret Navigation Mode

Caret navigation is a mode of operation in an application that enables you to use the keyboard to select text. The following table describes how to navigate HTML content in caret navigation mode in the Oracle Solaris Desktop Help browser, Firefox web browser, Thunderbird mail application, and Evolution mail application.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F7</td>
<td>Switches to caret navigation mode.</td>
</tr>
<tr>
<td>Left arrow</td>
<td>Moves one character to the left.</td>
</tr>
<tr>
<td>Right arrow</td>
<td>Moves one character to the right.</td>
</tr>
<tr>
<td>Up arrow</td>
<td>Moves up one line.</td>
</tr>
<tr>
<td>Down arrow</td>
<td>Moves down one line.</td>
</tr>
<tr>
<td>Ctrl+left arrow</td>
<td>Moves to the beginning of the previous word.</td>
</tr>
<tr>
<td>Ctrl+right arrow</td>
<td>Moves to the end of the next word.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scrolls up one page of content.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scrolls down one page of content.</td>
</tr>
<tr>
<td>Home</td>
<td>Moves to the beginning of the current frame.</td>
</tr>
<tr>
<td>End</td>
<td>Moves to the end of the current frame.</td>
</tr>
<tr>
<td>Shift+any of the keys listed above</td>
<td>Moves from the current position to the destination position and selects all text between the two positions.</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves focus to the next focusable control.</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Moves focus to the previous focusable control.</td>
</tr>
</tbody>
</table>

Chapter 4 • Using the Keyboard to Navigate the Desktop 65
Navigating Standard Elements and Controls

The following sections describe how to navigate and use standard user interface elements and controls from the keyboard.

Navigating Menus

The following table lists the keyboard shortcuts that you can use to navigate menus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Activates a button or submits a form.</td>
</tr>
<tr>
<td>Up arrow and down arrow</td>
<td>Gives focus to the next or previous menu item on a menu.</td>
</tr>
<tr>
<td>Right arrow</td>
<td>If the menu item that has focus is a submenu, opens the submenu and gives focus to the first menu item on the submenu.</td>
</tr>
<tr>
<td></td>
<td>If the menu item that has focus is not a submenu, opens the next menu on the menubar.</td>
</tr>
<tr>
<td>Left arrow</td>
<td>If the menu item that has focus is a submenu item, switches the focus back to the submenu.</td>
</tr>
<tr>
<td></td>
<td>If the menu item that has focus is not a submenu item, opens the previous menu on the menubar.</td>
</tr>
<tr>
<td>Return</td>
<td>Selects the focused menu item and closes the open menus.</td>
</tr>
<tr>
<td>Access key</td>
<td>Selects the menu item that is associated with the access key and closes the open menus.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Selects the focused menu item and closes the open menus except when the menu item is a check box or radio button. If the menu item is a check box or radio button, the menu does not close.</td>
</tr>
<tr>
<td>Esc</td>
<td>Closes the open menus.</td>
</tr>
</tbody>
</table>

Navigating Buttons

A button is a control that you use to start an action. Most buttons are rectangular and contain a text label.
The following table lists the keyboard shortcuts that you can use to navigate buttons.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spacebar</td>
<td>Activates the button that has focus. This is the equivalent of clicking on the button.</td>
</tr>
<tr>
<td>Return</td>
<td>Activates the button that has focus or, if no button has focus, performs the default action for the dialog.</td>
</tr>
</tbody>
</table>

**Navigating Radio Buttons**

A radio button is a control that you use to select one of several mutually-exclusive options.

The following table lists the keyboard shortcuts that you can use to navigate a set of radio buttons.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Selects the next or previous radio button and deselects the other radio buttons in the group.</td>
</tr>
</tbody>
</table>

**Navigating Check Boxes**

A check box is a control that you use to select or deselect an option.
The following table lists the keyboard shortcuts that you can use to navigate a check box.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spacebar</td>
<td>Selects or deselects the check box.</td>
</tr>
</tbody>
</table>

**Navigating Text Boxes**

Text boxes are controls in which you type text.

The following table lists the keyboard shortcuts that you can use to navigate a single line text box.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left arrow</td>
<td>Positions the cursor one character to the left.</td>
</tr>
<tr>
<td>Right arrow</td>
<td>Positions the cursor one character to the right.</td>
</tr>
<tr>
<td>Ctrl+left arrow</td>
<td>Positions the cursor at the start of the current word. Press and hold Ctrl and continue to press left arrow to position the cursor at the start of the previous word.</td>
</tr>
<tr>
<td>Ctrl+right arrow</td>
<td>Positions the cursor at the end of the current word. Press and hold Ctrl and continue to press right arrow to position the cursor at the end of the next word.</td>
</tr>
<tr>
<td>Home</td>
<td>Positions the cursor at the start of the line.</td>
</tr>
<tr>
<td>End</td>
<td>Positions the cursor at the end of the line.</td>
</tr>
<tr>
<td>Shift+left arrow or right arrow</td>
<td>Selects one character at a time to the left or right of the cursor.</td>
</tr>
<tr>
<td>Shift+Ctrl+left arrow or right arrow</td>
<td>Selects one word at a time to the left or right of the cursor.</td>
</tr>
<tr>
<td>Shift+Home</td>
<td>Selects all text to the left of the cursor.</td>
</tr>
<tr>
<td>Shift+End</td>
<td>Selects all text to the right of the cursor.</td>
</tr>
</tbody>
</table>
In addition to the keyboard shortcuts listed in the previous table, use the keyboard shortcuts in the following table to navigate multiline text boxes.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+A</td>
<td>Selects all text in the text box.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Positions the cursor at the top of the current view. Press Page Up again to position the cursor at the top of the previous view.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Positions the cursor at the end of the current view. Press Page Down again to position the cursor at the end of the previous view.</td>
</tr>
<tr>
<td>Ctrl+up arrow</td>
<td>Positions the cursor at the start of the current paragraph. Press and hold Ctrl and continue to press the up arrow key to position the cursor at the start of the previous paragraph.</td>
</tr>
<tr>
<td>Ctrl+down arrow</td>
<td>Positions the cursor at the end of the current paragraph. Press and hold Ctrl and continue to press the down arrow key to position the cursor at the end of the next paragraph.</td>
</tr>
<tr>
<td>Ctrl+Page Up</td>
<td>Positions the cursor one view width to the left.</td>
</tr>
<tr>
<td>Ctrl+Page Down</td>
<td>Positions the cursor one view width to the right.</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Positions the cursor at the start of the text box.</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>Positions the cursor at the end of the text box.</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Gives focus to the next control on the dialog.</td>
</tr>
<tr>
<td>Shift+Page Up</td>
<td>Selects the text to the start of the current view. Press and hold Shift and continue to press Page Up to extend the selection to the start of the previous view.</td>
</tr>
<tr>
<td>Shift+Page Down</td>
<td>Selects the text to the end of the current view. Press and hold Shift and continue to press Page Down to extend the selection to the end of the next view.</td>
</tr>
<tr>
<td>Shift+Home</td>
<td>Selects the text to the start of the line.</td>
</tr>
<tr>
<td>Shift+End</td>
<td>Selects the text to the end of the line.</td>
</tr>
<tr>
<td>Shift+Ctrl+up arrow</td>
<td>Selects the text to the start of the paragraph, then to the start of the previous paragraph.</td>
</tr>
<tr>
<td>Shift+Ctrl+down arrow</td>
<td>Selects the text to the end of the paragraph, then to the end of the next paragraph.</td>
</tr>
</tbody>
</table>
Navigating Standard Elements and Controls

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift+Ctrl+Home</td>
<td>Selects the text to the start of the text box.</td>
</tr>
<tr>
<td>Shift+Ctrl+End</td>
<td>Selects the text to the end of the text box.</td>
</tr>
</tbody>
</table>

**Navigating Spin Boxes**

A spin box is a control that allows you to type a numeric value or select a value from a list of all possible values.

**FIGURE 4–5**   Sample Spin Box

![Scroll back 500 lines](image)

The keyboard shortcuts that you use to navigate the text box area of a spin box are listed in "Navigating Text Boxes" on page 68. The following table lists the keyboard shortcuts that you can use to navigate the up and down arrows in the spin box.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up arrow or down arrow</td>
<td>Increases or decreases the value of the spin box by a small amount.</td>
</tr>
<tr>
<td>Page Up or Page Down</td>
<td>Increases or decreases the value of the spin box by a large amount.</td>
</tr>
</tbody>
</table>

**Navigating Drop-Down Lists**

A drop-down list is a control that you use to select one of several available items. The drop-down list contains a button that you use to display the available items.

**FIGURE 4–6**   Sample Drop-Down List

![Scroll bar: On the right side](image)

The following table lists the keyboard shortcuts that you can use to navigate a drop-down list.
Navigating Drop-Down Combination Boxes

A drop-down combination box is a text box with a drop-down list attached.

When the text box has focus, use the keyboard shortcuts that are listed in “Navigating Text Boxes” on page 68 to navigate the text box area. When the text box has focus, you can also use the keyboard shortcuts in the following table to navigate the drop-down list area.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up arrow</td>
<td>Selects the previous item from the drop-down list without displaying the list.</td>
</tr>
<tr>
<td>Down arrow</td>
<td>Selects the next item from the drop-down list without displaying the list.</td>
</tr>
<tr>
<td>Ctrl+down arrow</td>
<td>Opens the drop-down list.</td>
</tr>
</tbody>
</table>

When the drop-down list has focus, you can use the keyboard shortcuts that are listed in the following table to navigate the drop-down list.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up arrow</td>
<td>Selects the previous list item.</td>
</tr>
<tr>
<td>Down arrow</td>
<td>Selects the next list item.</td>
</tr>
</tbody>
</table>
Navigating Sliders

A slider is a control that you use to set a value in a continuous range of values.

The following table describes the keyboard shortcuts that you can use to navigate a slider.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left arrow or up arrow</td>
<td>Moves the slider left or up by a small amount.</td>
</tr>
<tr>
<td>Right arrow or down arrow</td>
<td>Moves the slider right or down by a small amount.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Moves the slider left or up by a small amount.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Moves the slider right or down by a small amount.</td>
</tr>
<tr>
<td>Home</td>
<td>Moves the slider to the maximum value.</td>
</tr>
<tr>
<td>End</td>
<td>Moves the slider to the minimum value.</td>
</tr>
</tbody>
</table>
Windows and dialogs are sometimes divided into logical sections that are displayed one section at a time on the window or dialog. The divisions are called tabbed sections and are identified by a tab with a text label.

The following table lists the keyboard shortcuts that you can use to navigate the tabbed sections of a window or dialog when a tab name has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left arrow</td>
<td>Gives focus to the previous tabbed section.</td>
</tr>
<tr>
<td>Right arrow</td>
<td>Gives focus to the next tabbed section.</td>
</tr>
<tr>
<td>Tab or Ctrl+down arrow</td>
<td>Gives focus to the first control on the active tabbed section.</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts that you can use to navigate the tabbed sections of a window or dialog when a control on a tabbed section has focus.

![Sample Dialog with Tabbed Sections](image)
Navigating Standard Elements and Controls

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+Page Up</td>
<td>Gives focus to the previous tabbed section.</td>
</tr>
<tr>
<td>Ctrl+Alt+Page Down</td>
<td>Gives focus to the next tabbed section.</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Gives focus to the next control outside the tabbed sections.</td>
</tr>
</tbody>
</table>

Navigating Lists

The following table lists the keyboard shortcuts that you can use to navigate multicolumn lists when a column header has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left arrow or right arrow</td>
<td>Gives focus to the previous or next column header.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Activates the header. This action usually sorts the list by the column header.</td>
</tr>
<tr>
<td>Tab</td>
<td>Gives focus to the list contents.</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts that you can use to navigate lists when the contents of the list has focus.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Selects the next or previous row or column.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Selects the top row of the list contents that are in view. Press Page Up again to select the top row of the previous view.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Selects the bottom row of the list contents that are in view. Press Page Down again to select the bottom row of the next view.</td>
</tr>
<tr>
<td>Home</td>
<td>Selects the first row in the list.</td>
</tr>
<tr>
<td>End</td>
<td>Selects the last row in the list.</td>
</tr>
<tr>
<td>Shift+arrow keys</td>
<td>For lists that support multiline selections, adds the next or previous row or column to the current selection. For lists that only allow single-line selections, selects the next or previous row or column.</td>
</tr>
<tr>
<td>Shift+Page Up</td>
<td>Selects all the rows between the current selection and the top row of the view.</td>
</tr>
</tbody>
</table>
Keys | Function
--- | ---
Shift+Page Down | Selects all the rows between the current selection and the bottom row of the view.
Shift+Home | Selects all the rows between the current selection and the first row in the list.
Shift+End | Selects all the rows between the current selection and the last row in the list.
Ctrl+Arrow keys | Gives focus to the next row or column but does not extend the selection.
Ctrl+Page Up | Gives focus to the top row in the view but does not extend the selection.
Ctrl+Page Down | Gives focus to the bottom row in the view but does not extend the selection.
Ctrl+Home | Gives focus to the first row in the list but does not extend the selection.
Ctrl+End | Gives focus to the last row in the list but does not extend the selection.
Return | Activates the item.
Ctrl+A | For lists that support multiline selections, selects all rows in the list.
Shift+Tab | Gives focus to the column header, if applicable.

**Navigating Trees**

A tree is a user interface control that contains sections that you can expand and collapse. A tree usually represents a hierarchical structure.
To navigate trees, you can use the same keyboard shortcuts that are listed in “Navigating Lists” on page 74. In addition, the following table lists the keyboard shortcuts you can use for the tree items.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (plus)</td>
<td>Expands the focused item.</td>
</tr>
<tr>
<td>- (minus)</td>
<td>Collapses the focused item.</td>
</tr>
<tr>
<td>Back Spacebar</td>
<td>Selects the parent item.</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Displays a search dialog. You can type the name of the tree items that you want to find.</td>
</tr>
</tbody>
</table>

**Customizing Your Keyboard Shortcuts**

Use the Keyboard Shortcuts preference tool to display the default keyboard shortcuts that you use to navigate the Oracle Solaris Desktop. You can customize the default keyboard shortcuts to meet your requirements. You can also create “hot keys”. Hot keys are keyboard shortcuts that start applications.

To start the Keyboard Shortcuts preference tool, choose System → Preferences → Keyboard → Shortcuts. The Desktop Shortcuts table lists the keyboard shortcut that is associated with each action.

![Sample Tree Structure](image)

**FIGURE 4–10** Sample Tree Structure

- Editor
- Print
  - Page
  - Fonts
- Plugins
  - Manager
To Customize Keyboard Shortcuts

1. Click the action for which you want to customize the keyboard shortcut.
   The row is highlighted.

2. Click on the keyboard shortcut in the Shortcut column.
   The text “Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.

3. Press the keys that you want to associate with the action.
   The new keyboard shortcut is displayed in the Shortcut column.

To Disable a Keyboard Shortcut

1. Click the action for which you want to disable the keyboard shortcut.
   The row is highlighted.

2. Click on the keyboard shortcut in the Shortcut column.
   The text “Type a new accelerator, or press Backspace to clear” is displayed in the Shortcut column.

   The keyboard shortcut is disabled.
Customizing the Appearance of the Desktop

This chapter describes the methods for users with visual impairments to change the appearance of the Oracle Solaris Desktop to enhance the accessibility of the desktop.

Customization Options

The following methods enable you to customize the appearance of the Oracle Solaris Desktop:

- **Themes** – Enable you to change the appearance of the desktop in an effective and consistent manner. See “Using Themes to Customize the Desktop” on page 80 for more information about themes and how to use them to achieve the required desktop environment.

- **Desktop and application-specific configuration settings** – Enable you to customize individual components of the desktop to achieve the required display settings. You can use this method as an alternative to using themes.

The following table summarizes the changes that you can make to the Oracle Solaris Desktop. This guide does not provide detailed instructions for customizing the desktop. For detailed instructions on how to customize the desktop using the customization tools provided by the desktop, refer to the Help for each tool or the *Oracle Solaris Desktop User Guide*.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall appearance of the desktop and using high-contrast colors, low-contrast colors, or large print</td>
<td>The Theme tab in the Appearance preference tool</td>
</tr>
</tbody>
</table>
### Using Themes to Customize the Desktop

This section describes customizing the appearance of the Oracle Solaris Desktop using themes.

#### Introduction to Themes

A *theme* is a collection of settings which modifies or controls the appearance of a desktop and its components in a consistent manner. When a theme is applied, the system simultaneously modifies various desktop components to achieve the required effect. For example, if you apply a theme that increases the font size across the desktop, it also modifies the panel size and the icons on the desktop for optimum compatibility with the font size.

### TABLE 5–1 Quick Reference to Customizing the Appearance of the Desktop (Continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop background appearance</td>
<td>■ The Background tab in the Appearance preference tool</td>
</tr>
<tr>
<td></td>
<td>■ The Edit → Backgrounds and Emblems menu item in the File Manager application</td>
</tr>
<tr>
<td>Font on the desktop background and in all desktop applications</td>
<td>The Fonts tab in the Appearance preference tool</td>
</tr>
<tr>
<td>Default font settings of the Text Editor or Terminal application.</td>
<td>The application’s Edit → Preferences menu item</td>
</tr>
<tr>
<td>Amount and type of window and workspace animation</td>
<td>The Visual Effects tab in the Appearance preference tool</td>
</tr>
<tr>
<td>Animation used to show and hide desktop panels</td>
<td>The General tab in the panel’s Properties dialog</td>
</tr>
<tr>
<td>Fonts and colors in received email messages</td>
<td>■ The Formatting options on the Display tab in the Thunderbird preferences dialog</td>
</tr>
<tr>
<td></td>
<td>■ The General tab on the Mail Preferences page in the Evolution preferences dialog</td>
</tr>
<tr>
<td>Fonts and colors on web pages</td>
<td>The Content tab in the Firefox preferences dialog</td>
</tr>
</tbody>
</table>
A theme contains the following settings that affect various parts of the desktop:

- **Controls**: Determines the visual appearance of all windows, applications, panels, and panel applications. It also determines the visual appearance of the GNOME-compliant interface items, such as menus, icons, and buttons. Some Controls options that are available in the desktop are designed for special accessibility needs.

- **Colors**: Determines the color scheme used to draw controls. If a theme does not support this feature, its color scheme is fixed by the theme’s designer and cannot be changed by the user.

- **Window Border**: Determines the appearance of frames around windows only.

- **Icons**: Determines the appearance of icons on panels and on the desktop background.

- **Pointer**: Determines the shape, color, and size of the mouse pointer.

For information about how to create your own themes, see the Oracle Solaris Desktop Administrator Guide.

### To Choose a Theme

1. **Choose System** → **Preferences** → **Appearance**.

2. **Click the Themes tab**.

3. **Choose a new theme from the list**.
   The system automatically applies the theme to the desktop.

### Available Themes

There are several themes available that suit different accessibility needs, as described in the following table:

<table>
<thead>
<tr>
<th>Theme Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Contrast</td>
<td>Provides dark text on a light background using high contrast colors.</td>
</tr>
<tr>
<td>High Contrast Inverse</td>
<td>Provides light text on a dark background using high contrast colors.</td>
</tr>
</tbody>
</table>
To Modify the Controls Setting for a Theme

1. Choose System → Preferences → Appearance.

2. In the Theme tab, select the theme that you want to modify.

3. Click the Customize button. The Customize Theme dialog is displayed.

4. Click the Controls tab to display the available controls options.

5. Select the controls option you want to associate with the current theme, and then click Close. The following table lists the controls options that are suitable for accessibility needs.

<table>
<thead>
<tr>
<th>Control Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Contrast</td>
<td>Provides dark text on a light background using high-contrast colors.</td>
</tr>
</tbody>
</table>
Control Option | Description
--- | ---
HighContrastInverse | Provides light text on a dark background using high-contrast colors.
LargePrint | Increases the size of controls to accommodate larger fonts. To increase the font size, you must use the Font preference tool. The background and foreground colors are the same as those specified by the Default desktop theme.
HighContrastLargePrint | Provides dark text on a light background using high-contrast colors. Increases the size of controls to accommodate larger fonts. To increase the font size, you must use the Font preference tool.
HighContrastLargePrintInverse | Provides light text on a dark background using high-contrast colors. Increases the size of controls to accommodate larger fonts. To increase the font size, you must use the Font preference tool.

▼ To Modify the Color Setting for a Theme

1. Choose System → Preferences → Appearance.
2. Click the Theme tab and then select the theme that you want to modify.
3. Click the Customize button.
   The Customize Theme dialog is displayed.
4. For each color that you want to change, click the color picker button, then select a new color.
   You can change the text and background colors of windows, text fields, tooltips, and selected objects such as text, list items, and window title bars.
5. Click Close to save your changes, or click Reset to Defaults to restore the theme's default color scheme.

▼ To Modify the Window Border Setting for a Theme

1. Choose System → Preferences → Appearance.
2. Click the Theme tab and then select the theme that you want to modify.
3 Click the Customize button. The Customize Theme dialog is displayed.

4 Click the Window Border tab to display the available window frame options.

5 Select the window frame option that you want to associate with the current theme from the list box, and then click Close.

▼ **To Modify the Icon Setting for a Theme**

1 Choose System → Preferences → Appearance.

2 Click the Theme tab and then select the theme that you want to modify.

3 Click Customize button. The Customize Theme dialog is displayed.

4 Click the Icons tab to display the available icon options.

5 Select the icon option that you want to associate with the theme from the list box, and then click Close.

The following table lists the icon options that are suitable for accessibility needs.

<table>
<thead>
<tr>
<th>Icon Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HighContrast</td>
<td>Provides dark on light icons using high-contrast colors.</td>
</tr>
<tr>
<td>HighContrastInverse</td>
<td>Provides light on dark icons using high-contrast colors.</td>
</tr>
</tbody>
</table>

▼ **To Modify the Mouse Pointer Setting for a Theme**

1 Choose System → Preferences → Appearance.

2 In the Theme tab, click the Customize button to open the Customize Theme dialog.

3 In the Customize Theme dialog, select the Pointers tab.

4 In the Pointer tab, select a pointer theme that supports resizing, for example, DMZ-White, redglass, or whiteglass.
Drag the Size slider to increase or decrease the size of the mouse pointer.

Close the dialog box.

**Customizing Specific Components of the Desktop**

This section describes how to customize specific components of the Oracle Solaris Desktop.

▼ **To Customize the Desktop Background**

To customize the desktop background:

1. Choose System → Preferences → Appearance

2. Select the Background tab.

   If no background is chosen, the first entry listed might be used.

   **Note** – The themes do not affect the desktop background.

▼ **To Set the Background to a Solid or Gradated Color**

1. Choose the first item from the list of backgrounds, which has the tooltip "No Desktop Background".

2. From the Colors drop-down list, choose Solid Color, Horizontal Gradient or Vertical Gradient, as required.

3. Click on the color picker buttons provided to choose either one solid color, or two gradient colors for the desktop background.

▼ **To Set the Background to a Picture**

1. Choose the picture from the list of backgrounds.

   If the picture you want to use does not appear in the list, either click the Add button to select it, or drag it into the list from the File Manager application.
2 From the Style drop-down list, choose how you want the picture to be placed on the background.
   If the picture does not fill the entire screen, the border will be filled using the colors specified by
   the Colors drop-down list and the color picker buttons.

▼ To Customize Desktop Background Objects

The size of the icons that are displayed on the desktop background is controlled by the File
Management preference tool.

To change the size of the icons:

1 In the File Manager window, choose Edit → Preferences.

2 Select the Views tabbed section.

3 In the Icon View Defaults group, select the zoom level that you require in the Default Zoom Level
drop-down list.

Customizing Fonts

This section describes how to customize the font settings for the desktop and frequently used
applications.

If you have difficulty with the default font type and font size that is used on the desktop and
desktop background, you can customize the font settings.

You can specify individual font settings for the following desktop components and applications:

- Entire desktop (excluding the desktop background)
- Desktop background only
- Terminal
- Text editor
- Help
- Web Browser
- Email (Thunderbird or Evolution)

Customizing the Desktop Fonts

The Appearance preference tool enables you to specify the default fonts for the desktop.

To start the Appearance preference tool, choose System → Preferences → Appearance.

The Fonts tab contains the following options:
Application font

Sets the default font to use for the text that is displayed on the desktop, including the text displayed on the windows and dialog boxes associated with GNOME-compliant applications and panel applications.

**Note** – If you use a predefined theme and you click Apply Font, the font associated with the theme overrides the font selected from the Appearance preference tool.

Document font

Sets the font to use for displaying documents.

Desktop font

Sets the font to use for the text displayed on the desktop background only.

Window title font

Sets the font to use for the text that is displayed in the title-bars of your windows.

Fixed width font

Click this button to select a font to use when an application such as a terminal or text editor wants to display text in a nonproportional font.

Font rendering

To specify how to render fonts on the desktop, select one of the following options:
- Monochrome
- Best shapes
- Best contrast
- Subpixel smoothing

**Note** – If you use large fonts, you might need to change the size of panes in applications that use panes such as, the File Manager and the Help Browser.

### Customizing Application Fonts

By default, the applications use the default font specified in the Appearances preference tool. The following applications allow the default font to be customized:

- Help Browser
- Text Editor
- Terminal
- Web Browser
- Email (Thunderbird or Evolution)
Meeting Specific Accessibility Needs

The following sections summarize the steps that you need to take to improve the accessibility of the desktop in a particular area.

▼ To Achieve a High-Contrast or Low-Contrast Desktop

1. Use the Appearance preference tool to select the high contrast or low contrast desktop theme that you require.

2. Use the Background tab to customize your desktop background as follows:
   a. Set the desktop background to No Desktop Background.
   b. Set the Colors to Solid Color.
   c. Select a background color.

3. In the Terminal application, ensure that the Use Colors From System Theme option is selected in the Colors tab of the Editing Profile dialog.

4. In the gedit Text Editor application, ensure that the Classic color scheme is selected in the Fonts & Colors tab of the Preferences dialog.

▼ To Achieve a Large Print Desktop

1. Use the Appearance preference tool to select the Large Print theme.

2. Click the Apply Font button to increase the size of the font that is used on the desktop and on window frames.

3. Use the Desktop Font option in the Font preference tool to increase the font size that is displayed on desktop background objects.
   If the Use System Fixed Width Font option is selected on the General tab of the Terminal Preferences dialog, the terminal uses the font size that is specified in the large print theme that you selected. However, if the Use System Fixed Width Font option is not selected, click the font selection button to increase the font size that is used to display text in the terminal.
4 **Determine the gedit font size.**

If the Use Default Theme Font option is selected in the gedit Preferences dialog, gedit uses the font size that is specified in the large print theme that you selected. However, if the Use Default Theme Font option is not selected, increase the font size that is used to display the contents of the gedit text editor window.

**Note** – If you use applications that use panes, such as the File Manager and the Help Browser, you might need to change the size of panes to accommodate large print. See the online help for the appropriate application for more information.
This chapter describes the tasks that a system administrator needs to perform to enable accessible login and to facilitate the use of the assistive technologies that are available in the Oracle Solaris Desktop.

Configuring the Desktop for Accessible Login

The Oracle Solaris Desktop includes an Accessible Login feature. The Accessible Login feature enables users to do the following:

- Log in to the desktop even if the user cannot easily use the screen, mouse, or keyboard in the usual way.
- Launch assistive technologies at login by associating a user action with an assistive technology application. The user can perform the user action from the standard keyboard, or from a keyboard, pointing device, or switch device that is attached to the USB or PS/2 mouse port. These user actions are called gestures.
- Change the visual appearance of the login dialog before the user logs in, for example, to use a high contrast theme for better visibility.

For information about using and configuring the accessibility features of the login screen, see the GNOME Display Manager Reference Manual.

Configuring the Java Environment for Accessibility on Oracle Solaris Systems

You can configure the Java environment on the Oracle Solaris Systems.
To Configure the Java Environment on Oracle Solaris Systems

1 Log in as the root user to the base directory of the Java SDK installation.

2 Change to the jre/lib directory.
   # cd jre/lib

3 Type the following command:
   # ln -s /usr/share/jar/accessibility.properties

4 Change to the ext directory.
   # cd ext

5 Type the following command:
   # ln -s /usr/share/jar/gnome-java-bridge.jar

Enabling XKB on Oracle Solaris Systems

If you are using the desktop for the Oracle Solaris operating system on a SPARC platform, you must enable XKB on your system before you can use the AccessX preference tool, Screen Reader and Magnifier, or On-Screen Keyboard.

Note – XKB is not currently supported on Sun Ray systems.

To Enable XKB on a Non-Sun Ray Oracle Solaris System

1 Log in as the root user.

2 Check whether the path and the /etc/dt/config/Xservers file exists on your system.

3 If the /etc/dt/config directory does not exist, type the following command:
   # mkdir -p /etc/dt/config

4 If the Xservers file is not present, type the following command:
   # cp /usr/dt/config/Xservers /etc/dt/config/Xservers

5 In the Xservers file, scroll to the end of the file.
6 Append the following line to the command line at the end of the file.
   `+kb`

7 Save and close the `Xservers` file.

8 Type the following command on a command line:
   `pkill -HUP dtlogin`

9 In the `/etc/X11/gdm/gdm.conf` file, scroll to the end of the file until you see the line `server -standard`.

10 Edit the command line in this section to append the following to the end of the line:
    `+accessx +kb`

11 Save and close the `gdm.conf` file.

12 Log out of your session and log in again.

13 To verify whether XKB is running, type the following command:
   `xdpyinfo`

14 Search for XKEYBOARD in the extensions list.

---

**Configuring Alternative Pointer Devices**

The following sections describe how to configure your system to use a standard physical mouse and another pointer device such as a single switch device or head-tracker device, and how to configure On-Screen Keyboard to use the second pointer device.

---

**To Configure Alternative Pointer Devices on Oracle Solaris Systems**

Note – This procedure does not work on all Oracle Solaris platforms.

1 Before you connect the alternative pointer device to your system, list the existing devices.
   `# ls -l /dev/usb/hid*`

2 Connect the alternative pointer device to your system.
3 List the new device.
   # ls -l /dev/usb/hid*

4 In the file /usr/openwin/server/etc/OWconfig, add the following lines.
   # Sun Mouse module
   class="XINPUT" name="IMOUSE2"
   dev="/dev/usb/hid2" strmod="usbsns"
   ddxHandler="ddxSUNWmouse.so.1"
   ddxInitFunc="ddxSUNWmouseProc";

   where:
   - The name option starts with the string IMOUSE but is extended to form a unique string, such as IMOUSE2 or IMOUSE3, depending on the number of existing devices.
   - The dev option specifies the device name that you identified in Step 3.

5 Remove the following lines from the OWconfig file.
   # Null Mouse module class="XINPUT" name="NMOUSE"
   ddxHandler="ddxSUNWmouse.so.1" ddxInitFunc="ddxnullmouseProc";

6 Save the /usr/openwin/server/etc/OWconfig file.

7 Restart the X Server.

▼ To Configure Two USB Mouse Devices on Oracle Solaris x86 Systems

1 Before you connect the second mouse to your system, list the existing devices:
   # ls -l /dev/usb/hid*

2 Connect the second mouse to your system.

3 List the new device.
   # ls -l /dev/usb/hid*

4 In the file /etc/X11/xorg.conf, edit the ServerLayout section as follows:
   Section "ServerLayout"
      Identifier    "X.org Configured"
      Screen 0 "Screen0" 0 0
      InputDevice "Mouse0" "CorePointer"
      InputDevice "Mouse1"
      InputDevice "Keyboard0" "CoreKeyboard"
   EndSection
5 Edit the InputDevice section as follows:

```
Section "InputDevice"
  Identifier "Mouse0"
  Driver "mouse"
  Option "Protocol" "VUID"
  Option "Device" "/dev/mouse"
EndSection
```

6 Insert a second InputDevice section as follows:

```
Section "InputDevice"
  Identifier "Mouse1"
  Driver "mouse"
  Option "Protocol" "VUID"
  Option "StreamsModule" "usbms"
  Option "Device" "/dev/usb/hidx"
EndSection
```

where:

```
/dev/usb/hidx
```

is the device name that you identified in Step 3.

7 Save the `/etc/X11/xorg.conf` file.

8 Restart the X Server.
Index

A
accessible login feature, 91

C
caret navigation mode, 53–54, 65–66
configuring two pointer devices, on Oracle Solaris
systems, 93–94
configuring two USB mouse devices on Oracle Solaris
systems, 94–95
cursor, stop blinking, 49
customizing the desktop appearance, 79–80
desktop background, 85
desktop background objects, 86
desktop fonts, 86–87
fonts, 86–87

H
high contrast desktop, 88

J
Java environment, configuring, 91

K
keyboard shortcuts
  customizing, 76–77
keyboard shortcuts (Continued)
  essential, 53–54
  for applications, 62–64
  for buttons, 66–67
  for check boxes, 67–68
  for desktop background, 55–56
  for dialogs, 63–64
  for drawers, 57–58
  for drop-down combination boxes, 71–72
  for drop-down lists, 70–71
  for file manager, 64–65
  for Help content, 65–66
  for lists, 74–75
  for menus, 66
  for menus on panels, 58
  for paneled windows, 61–62
  for panel applications, 58–59
  for panels, 56–59
  for radio buttons, 67
  for sliders, 72
  for spin boxes, 70
  for tabbed sections, 72–74
  for text boxes, 68–70
  for windows, 59–62
  for workspaces, 59
  global, 54–55
  to control a window, 60
  to give focus to a window, 59–60
  to move a panel object, 56–57
  to move a window, 60–61
  to resize a window, 61
Index

L
large print desktop, 88–89
low contrast desktop, 88

O
Orca modifier keys, 32

S
Screen Reader and Magnifier, disabling screensaver, 45

T
themes, 80–81
  creating your own, 81
desktop, 81–82
icon, 84

X
XKB, 92